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1 Introduction 

i-CHoose allows you to create custom integrated manifolds (HIC), compact directional valves assemblies (CDV) and 

also compact power module (CPM) projects from the early design stages all the way through pricing and quoting your 

customers.  This innovative software allows you to integrate, simplify, and cut costs in your hydraulic systems using 

Bosch Rexroth components. 

The integrated product selector and configurator allows users to determine the price of individual components or of a 

complete project assembly. You can then generate a quote directly from i-CHoose.  With embedded component-based 

3D models, you can easily insert and layout elements on a block or connect modules to create compact valve or power 

module assemblies, with dimensions, and weight estimations.   

This 3D layout will then be used to assist engineers in designing Bosch Rexroth systems, or to show customers a visual 

and dimensional estimation of what their assembled project would look like upon completion. 

1.1 Document Content 

The main goal of the i-CHoose software is to make it possible to select and configure elements that 

are part of a custom manifold (HIC), a compact directional valve (CDV) or a compact power 

module (CPM) assembly. 

In this i-CHoose User’s Guide, we have included all the instructions on how to use the software in 

order to draft the schematic, configure components and layout the assembly to obtain a unique 

Bosch Rexroth solution. This content has been organized so that all sections are sorted to follow a 

logical order. 

However, this document covers neither the technical aspects of the components, manifold systems, 

compact directional valves nor compact power modules. For more information, refer to the Bosch 

Rexroth documentation or the Bosch Rexroth website: http://www.boschrexroth.com/  

This i-CHoose User’s Guide contains the following chapters: 

 

Chapter Contents 

1 Introduction 

2 Getting Started – The Interfaces 

3 Building a First Project 

4 Documentation 

http://www.boschrexroth.com/
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2 Getting Started – The Interfaces 

. 

2.1 Welcome Screen 
Once the application is open, the user is prompted with the i-CHoose Welcome Screen. This welcome screen is 

intended to ease the access to recent projects, existing projects or to create new projects. 

The welcome screen contains the following major sections: 

1. The “Recent Projects” List: Contains the list of the most recently opened projects; 

2. The “Open Project” Button: Is used to search for and open an existing project; 

3. The “New Project” List: This section contains the buttons used to create a new project according to the 

available i-CHoose project types: 

• HIC 

• CDV 

• CPM 
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Figure 2-1: i-CHoose Welcome Screen 
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2.2 Main Interface 

The main interface contains multiple elements that will change depending on the section of the software that is 

currently in use.  Therefore, the main interface is designed in a way which facilitates access to the various 

sections of the software. i-CHoose interfaces are based on standard Windows interfaces and include additional 

items specifically designed for this application. 

The main interface contains the following major sections: 

1. The application header: Contains the menus and toolbars; 

2. The “Project Explorer” window: Allows the user to switch between interfaces; 

3. The main display: This section will change depending on the selection made in the “Project Explorer”; 

4. The “Library Explorer” window: Allows the user to access the application components that can be used 

in the hydraulic circuit. This interface changes depending on the main display in use. The libraries of the 

main interfaces will be covered in more detail later; 

5. The “Messages” window: Lists all the errors/warnings that occurred during the manifold design process. 

 

Figure 2-2: i-CHoose Interfaces 

The header is based on a standard Windows interface (Ribbon Bar).  This section of the application holds the 

various menus / toolbars needed to access the main software features and tools. 
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Figure 2-3: Application Header (Design) 
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2.2.1 Menu (i-CHoose) 

The menu found in i-CHoose works just like any other standard Windows application (Ribbon Bar). 

 

 

Figure 2-4: i-CH→ i-CHoose Menu 

2.2.1.1 Content of the Menu 

The menu contents are: 

1. Nothing Selected → Recent Documents 
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2. New Project 

 

3. Project 
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4. Print Preview 

  

5. Print 
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6. Import / Export 

 

7. Validate with Automation StudioTM 
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8. Preferences 

  

 

9. Support 
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2.2.1.2 Design Toolbar 

2.2.1.2.1 Hydraulic Circuit (Schematic) 

The “Design” toolbar is used to quickly access the explorer, clipboard, drawing, connection line, layout and 

settings groups: 

 

Figure 2-5: Design Toolbar (Hydraulic Circuit) 

Explorer Group: 

 

Button Description Function 

 
Library Explorer Opens/Closes the Library window 

 
Project Explorer Opens/Closes the Project Explorer window 

 
Message Explorer Opens/Closes the Error List & Messages window 

 

 

Clipboard Group: 

 

Button Description Function 

 
Paste Pastes the content of the clipboard 

 Cut Cuts the selection 

 Copy Copies the selection to the clipboard 

 Delete Deletes the selected items 

 

Drawing Group: 

 

Button Description Function 

 Select 
Returns the mouse pointer to the normal mode when creating 

graphical elements. 

 Line Inserts a line 

 Rectangle Inserts a rectangle 

 Ellipse Inserts an ellipse 

 Text Inserts text 

 Image Inserts an image 

 Style Modifies the line style of a graphical element 

 Thickness Modifies the thickness of a graphical element 

 Color Modifies the color of a graphical element 
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Connection Line Group: 

 

Button Description Function 

 
Line Type 

Modifies the selected lines’ types or the default line 

type if no line is selected. 

 Direct Line 
Transforms an orthogonal connection line into a 

straight line between two connection points 

 Insert Line Inserts a connection line 

 Line Style Modifies the selected lines’ style 

 Line Color Modifies the selected lines’ color 

 Line Thickness Modifies the selected lines’ thickness 

 

Layout Group: 

 

Button Description Function 

 Group Manipulation  Rotates the selection (group) to the right 

 Rotate Left Rotates the active component 90 degrees left 

 Rotate Right Rotates the active component 90 degrees right 

 Flip Horizontal Flips the active component over a vertical axis 

 Flip Vertical Flips the active component over a horizontal axis 

 Component Snap Snaps the component to the grid 

 

Settings Group: 

 

Button Description Function 

 
Current Circuit Setup… Opens the “Current Hydraulic Circuit Options” dialog 

2.2.1.2.2 3D Layout 

Some features are specific to the 3D Layout: 

 

Figure 2-6: Design Toolbar (3D Layout) 

Block Group (HIC Only): 

 

Button Description Function 

 Compact Block 
Shrinks the block manifold dimensions to its minimum without 

moving any components 

 Show Resize Handles 

Displays the resize handles which are used to resize the block 

manifold by dragging its edges while in “flat” mode in the 3D 

layout display 

 Block Dimensions 
Opens the dialog that is used to manually define the block 

dimensions 

 Grid Properties Defines the grid spacing 
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Button Description Function 

 Component Snap Snaps the component to the grid 

Dimensions Group: 

 

Button Description Function 

 
Create Dimension Draws dimensions: linear or ordinate 

 

Component Group: 

 

Button Description Function 

 Component Location* Define the component location 

 Lock Component Position* Locks a component in its current position (HIC Project) 

 Restrict Component to Surface* Locks a component to the current manifold face (HIC Project) 

 Set Angle* Defines the component angle 

 Rotate Left Rotates the active component 90 degrees left 

 Rotate Right Rotates the active component 90 degrees right 

 Counterboring* Define the counterbore parameters 

* HIC Only 

 

2.2.1.3 View Toolbar 

2.2.1.3.1 Hydraulic Circuit (Schematic) 

The “View” toolbar is used to quickly access the various visualization functions: 

 

Figure 2-7: View Toolbar 

Show Group: 

 

Button Description Function 

 Grid Displays/Hides the grid 

 Connection Port Displays/Hides the connection port 

 Connection Port Name Displays/Hides the connection port name 

 Reference Displays/Hides the component references 

 Title Block Displays/Hides the title block 

 Component Label Displays/Hides the component labels 

 Component Position Displays/Hides the item position 

 Components not on block* 
Highlights/Unhighlights the components that are not yet 

positioned on the block  

* HIC Only 
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Navigate Group: 

 

Button Description Function 

 Zoom Out Zooms out of the design by 25% 

 Zoom In Zooms into the design by 25% 

 Zoom Selection Zooms into a specific selection 

 Zoom Page Zooms in order to display the whole page on the screen 

 Pan Pans the schematic (Moves the page) 

 

Window Group: 

 

Button Description Function 

 Horizontal Tile Arranges the windows in a horizontal tile layout 

 Vertical Tile Arranges the windows in a vertical tile layout 

 Cascade Arranges the windows in a cascade layout 

 
Switch Windows Switch the active window 

2.2.1.3.2 3D Layout 

Some features are specific to the 3D Layout: 

 

Figure 2-8: View Toolbar (3D Layout) 

 

Show Group: 

 

Button Description Function 

 Components* Displays/Hides the components in the 3D layout view 

 Transparency 
Displays the block in one of the 3 following states:  Opaque, Transparent or 

Invisible. (Opaque view by default) 

 Grid* Displays/Hides the grid 

 Reference Axis* Displays/Hides the reference axis 

 Leader Displays/Hides the satellite owner 

 Component Label Displays the component IDs 

 Interferences* Displays/Hides the interferences 

 Dimensions* Displays/Hides the dimensions 

 Placement Locks* Displays/Hides the placement locks 

 Thread Displays/Hides the cavity threads 

 

 
Spacing Adds and increases the spacing between 3D Objects 

* HIC Only 
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Navigate Group: 

 

Button Description Function 

 Rotate Used to rotate the block in the layout display 

 

2.2.1.4 Finalize Toolbar 

The “Finalize” toolbar is used to quickly access the various functions available in the “Edit/View” menu: 

 

Figure 2-9: Finalize Toolbar 

Review Group: 

 

Button Description Function 

 
Design Check Verifies the configuration rules 

 

Validation Group: 

 

Button Description Function 

 
Validate with Automation Studio™ 

Exports the schematic into an Automation Studio compatible 

format in order to simulate and validate it. 

 

Generate Group: 

 

Button Description Function 

 
Generate Report(s) 

Generates the assembly report depending on the user rights (Sales 

Manager, Distributor or OEM) 

 

Import/Export Group: 

 

Button Description Function 

 
Import/Export 

Exports the document in the selected format or opens the 

imported compatible format 

 

Production Group: 

 

Button Description Function 

 
Interference Check Verifies all the 3D object interferences 
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2.2.2 Project Explorer 

The “Project Explorer” lists all the opened projects and is used to select the interface that will appear in the 

main display area. The user has the choice between six interfaces. These interfaces are: 

 

Project Type Choice Impact 

HIC 

CDV 

CPM 

  Project Parameters Takes the user to the “Project Parameters” page in the main display. 

Hydraulic Circuit Takes the user to the “Hydraulic Circuit” page in the main display. 

3D Layout Takes the user to the “Isometric Layout” page view in the main display. 

Part List Takes the user to the “Part List” page in the main display. 

Technical Data 

(HIC only) 
Takes the user to the “Technical Data” page in the main display. 

Technical Drawing Takes the user to the “Technical Drawing Layout” page in the main display 

The project explorer window is opened and closed with the “Project Explorer” button  located in the 

“Design” toolbar.   

 

Figure 2-10: Project Explorer (HIC Example) 

2.2.2.1 Multiple Projects Management 

When several projects are opened during the same work session, they will all be listed in the “Project 

Explorer” window. It is then possible to copy and paste components from the “Hydraulic Circuit” interface 

of a project to another one (As long as the project types are the same, HIC/HIC; CDV/CDV, etc, …). 

It is also possible to use the tiled or cascade functions in the “Window” menu to display one or more 

projects at a time. 



 i-CHoose User's Guide 

  

 2-16 

  

Figure 2-11: One of each project type listed in the Project Explorer 

2.2.2.2 Project Explorer Contextual Menu 

In the “Project Explorer” window, right-click on a project name to access its contextual menu. 

The “Project Explorer” contextual menu is used to: 

1. Save the current project; 

2. Close the current project; 

3. Rename the current project; 

4. Access the “Revision History” dialog box. 

 

Figure 2-12: Project Explorer Contextual Menu 
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2.2.3 Main display 

The main display will change with respect to the interface selection that has been made.  As discussed 

previously, the main display will have six interfaces: 

1. Project Parameters; 

2. Hydraulic Circuit; 

3. 3D Manifold Layout (HIC) or 3D CDV Layout (CDV) or 3D CPM Layout (CPM); 

4. Part List 

5. Technical Data (HIC Only) 

6. Technical Drawing. 

2.2.4 Warning Messages 

Errors and Warning messages are displayed to inform the user that some rules have not been respected 

during the design phases. These messages could appear while working in all six interfaces (document 

types). 

An indication that a message is pending appears in the status bar at the bottom of the application window. 

 

Figure 2-13: Pending Message in the Status Bar 

To make the warning disappear from the status bar, open the “Error List & Messages” window. There are 

two ways to open it: 

1. Click on the warning message directly in the status bar; 

2. Click on the “Message Explorer” button in the “Explorer” group of the toolbar. This will open the 

“Error List & Messages” window if it was closed or close it if it was opened. 

 

Figure 2-14: Errors/Warnings in the Error List & Messages Window 

The “Error List & Messages” window lists all the errors, warnings and messages that have been displayed in 

the current work session. To clear the messages, click on the “Clear & Refresh” button located on the top-

right of the window. 
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2.3 Working with Project Files 

2.3.1 Creating a New File 

To create a new file: 

3. Select the “New Project” command from the “i-CHoose” menu; 

4. Select the project type (HIC, CDV or CPM). 

 

Figure 2-15: “New Project” Menu 

This will create a new project that appears in the “Project Explorer”. When a project is created it will have a 

default name. It can be renamed at any time. 

Users can also click on the desired project type button from the “New Project” section of the “Welcome 

Screen” to create a new project file. 

2.3.2 Opening a File 

To open a file: 

1. Select the “Open File” command in the “i-CHoose / Project” menu; 
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Figure 2-16: Project / Open File Menu 

A standard Windows browser for file opening appears.   

2. Use the browser to find the desired file with the extension .ch3d or .chTemplate, which are respectively 

the i-CHoose project and i-CHoose template format and select it; 

3. Click on the “Open” button. 

The project opens and appears in the “Project Explorer”. All saved information is retrieved and all 

interfaces, options and information are updated accordingly. 

Users can also click on the “Open Project” button from the bottom section of the “Welcome Screen” to open 

an existing project file. 

 

Notes:  

The symbols and underlying configuration features do not update automatically 

when a project is loaded. That is, the symbol and configuration are specific to a 

project. If there is any doubt that the symbol or features have been updated, the 

user should re-insert the component into the project. The symbols and 

configuration features are part of the component database. The revision level of the 

component database can be found in the “About” dialog box under the “Help” 

menu. 
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Figure 2-17: File Opening Browser 

2.3.3 Saving a File 

Three options are available to save a project: 

1. Select the “Save File” command from the “i-CHoose / Project” menu; 

 

Figure 2-18: Project / Save File Menu 

Or 

1. Click on the “Save File”  button in the “Quick Access” toolbar; 

Or 

1. Use the “Save” command from the contextual menu in the “Project Explorer” (right-click on the project 

name); 
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Figure 2-19: Contextual Menu 

If the file has not been previously saved, the browser window opens.  If the file has been previously saved, 

the application will overwrite the last saved file version. 

2. Select the folder where the file will be saved; 

3. Type the name of the file in the “File Name” field; 

4. Click on the “Save” button. 

 

Figure 2-20: File Saving Browser 

Note: To help in the design process, the software provides methods to build project 

templates. The user can save a project as a template file and re-use it later. 

(Example: Fan Drive Application.chTemplate) 

These templates can be used to start new projects. 
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2.3.4 Saving a File As… 

Using the “Save As…” command is the same as using the “Save” function for the first time. It is mostly 

used to save the file with a different name or to create a backup.   

Note: If you rename the file in Windows Explorer, the project name will be 

modified in i-CHoose.  The project name and file name are linked.   

2.3.5 Printing the Current Configuration 

The manifold configuration can be printed at any time during the design process. Whether in the “Hydraulic 

Circuit” or in the “3D Layout” interface, the user has the option to choose what to send to the printer. 

To print the current project configuration: 

1. Select the “i-CHoose” menu → “Print” → “Hydraulic Circuit”, “3D View” or “Technical Drawing”; 

 

Figure 2-21: Print Menu 

2. Select the options that pertain to the printer set-up and print location in the dialog box; 

3. Click on OK; 

4. The chosen interface will be sent to the printer. 

2.3.6 Previewing the Printing of the Current Configuration 

To preview the current manifold configuration: 

1. Select the “i-CHoose” menu” → “Print Preview” → “Hydraulic Circuit”, “3D Layout” or “Technical 

Drawing”; 
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Figure 2-22: Print Preview Menu 

2. Select the options that pertain to the printer set-up and location in the print dialog; 

3. Click on OK; 

4. The current configuration will be displayed on the screen in a “Print Preview” window; 

2.3.7 Importing and Exporting 

2.3.7.1 Exporting to DXF or to STEP 

To export a diagram to a DXF or STEP file format: 

1. Select the “i-CHoose” menu → “Import/Export” → “Export to DXF” or “Export to STEP” command; 
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Figure 2-23: Import / Export Menu 

A “Save As…” dialog box opens. 

2. Select the desired folder to save to; 

3. Click on the “Save” button.  

Note: The .dxf format used is compatible with AutoCAD® 2000 and later 

revisions. 

2.3.7.2 Exporting 3D Layout to XML 

To export the component 3D position information into an XML file: 

1. Select the “i-CHoose” menu → “Import/Export” → “Export 3D Layout to XML” command; 
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Figure 2-24: Export 3D Layout to XML Menu 

A “Save As” dialog box opens. 

2. Select the folder to save to; 

3. Click on the “Save” button.  

Note: All the components are exported to the XML file, even if they are not 

inserted on the manifold block. 

2.3.7.3 Importing from XML 3D 

To import the components’ 3D positions in the current project from an XML file: 

1. The selected manifold project must use the components listed in the XML file you want to import. 

2. Select the “i-CHoose” menu → “Import/Export” → “Import 3D Layout from XML” command; 
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Figure 2-25: File Menu (Import 3D Layout from XML) 

An “Open” dialog box appears. 

3. Select the .xml file to import; 

4. Click on the “Open” button.  

Note: The positions of the components listed in the XML file will be automatically 

updated in i-CHoose. The manifold layout views will be refreshed accordingly. 

2.3.7.4 Importing a HIC project in a CDV Project (CDV or CPM Project Only) 

It is possible to import a HIC block into a CDV or CPM Project. To do this, select the “i-CHoose” → 

“Import / Export” → “Import a HIC Project…” command. The user may then select the .ch3d file to import 

 

2.3.7.5 Importing a CDV project in a CPM Project (CPM Project Only) 

It is possible to import a CDV assembly into a CPM Project. To do this, select the “i-CHoose” → “Import / 

Export” → “Import a CDV Project…” command. The user may then select the .ch3d file to import 

 

2.3.7.6 Exporting to Automation Studio 

 

To export to Automation Studio: 

1. Select the “i-CHoose” menu → “Validate with Automation StudioTM” command; 
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Figure 2-26: “Validate with Automation Studio” Menu 

 

Figure 2-27: “Validate with Automation Studio” Dialog 

A “Save As…” dialog box opens. 

2. Select the desired folder to save to; 

3. Click on the “Save” button.  

Note: The .chx format used is compatible with Automation Studio version 6.0 and 

higher. 
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2.4 Software and files updates 

You can check if new software releases or databases are available by using the “Support / Check for Update” 

Menu (an Internet connection is required for this feature to work properly). 

The software update check can generate 3 cases: 

• The update server is not responding 

 

Figure 2-28: Data Server Not Available 

• The update server does not have new versions 

 

Figure 2-29: Software is Up-to-date 

• The update server has an available update 

 

Figure 2-30: Software Updates are Available 

You can click on the “i-CHoose Installation Package – v3.X.X.XXXX” button or the “i-CHoose Price – 

vX.X.XXXX” button when available; otherwise the window can only be closed. This action launches the 

current browser with the Bosch Rexroth server address. The user can then download the latest version and 

install it on their computer (The i-CHoose application must be closed prior to the update operation). 



 

 

3 Building a First Project 

. 

3.1 Creating a Manifold Project (HIC) 
When you begin a new project, you will start on the “Project Parameters” page where specific 

technical parameters can be set as default values that will carry throughout all component 

selections. You may also choose to start on the Hydraulic Circuit page where you can quickly and 

easily create your circuit using the drag-and-drop feature. After designing the circuit, you can move 

on to the “3D Layout” page where you will specify the locations of the valves, ports and mounting 

holes, and define the maximum envelope dimensions. There is also a “Part List” that can be used to 

quickly review the bill of materials and manifold costs at any point throughout the design process.  

When the manifold design and layout is complete, the software has a built-in design check that will 

provide a variety of detailed errors and warnings for issues such as incomplete product 

specifications, errors in component size, pressure or flow setting, etc. You can then create the 

“Technical Drawing” where you can summarize all of the manifold assembly details by laying 

down on a single or multiple page(s) the schematic, the BOM and some of the 3D views which can 

be fully customized. 

When you are ready to see the final draft of your project, you can generate a report. The report 

contains information from all parts of the project; customer or distributor information, technical 

parameters, the circuit schematic, the manifold layout, the bill of materials, warnings, and the 

revision history. 

3.1.1 Project Parameters Interface 

The first step in creating a new manifold design is to describe the project and its technical parameters. The 

project parameters interface is designed for this specific purpose. It allows the user to define the basic 

information needed to build a Bosch Rexroth custom manifold. This information can be general, commercial 

or technical. The interface is divided in four sections. 

1. Project Information 

2. Customer Information 

3. Commercial Information 

4. Technical Information 
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Figure 3-1: Project Parameters Interface for Manifold Projects 

3.1.1.1 Accessing the Project Parameters Interface 

To access the Project Parameters interface: 

1. Open the “Project Explorer”; 

2. In the desired project, click on the “Project Parameters” branch. 

 

3.1.1.2 Project / Customer / Commercial Information 

These sections are used for information purposes only. They will appear on the report and can be consulted at 

any time while using the software but this information has no impact on the choices offered to the user during 

the design process.  

Some parameters are mandatory to generate a valid report. A “Check” sign, located to the right of a parameter, 

means it is mandatory. By default, the sign color is orange . 

If the parameter has been set, the sign becomes green . 

 

3.1.1.3 Technical Project Parameters 

Technical project parameters are used as references while the user is designing the system. Therefore, the 

choices made / entered in this section of the interface will have an impact on the design process.  
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3.1.1.4 Selecting Default Values 

Default values are selected so that they will appear by default in the component properties interface. If a 

selection is made and a situation occurs where it does not exist in the component options, the first available 

option will be selected by default. The fields for which a default value can be set are: 

1. Coil Voltage; 

2. Coil Termination. 

Note: Default values can be overwritten during the configuration process. 

 

3.1.2 Hydraulic Circuit Interface  

The Hydraulic Circuit interface is used to design the actual hydraulic circuit that will later be used to create 

the Bosch Rexroth custom manifold. The interface is split into two major areas: 

1. The part library; 

2. The diagram editor. 

3.1.2.1 Accessing the Main Design Interface 

To access the main circuit design interface: 

1. Click on the “Project Explorer”  button in the “Design” toolbar; 

2. In the desired project, click on the “Hydraulic Circuit” branch. 

The main display will show the circuit design interface. 

3.1.2.2 Part Library 

The “Library Explorer” is the main tool for selecting components and building circuits. To access the “Library 

Explorer”: 

1. Click on the “Library Explorer”  button in the “Design” toolbar; 

2. Browse the various categories using the + sign and by selecting various categories in the library.  

Or  

Use the search engine to find the component you want. 

Components and their description / model code appear in the component viewer / selector window. 

Note: The contents of the library will change depending on the selected interface and 

the project type currently in use. 

3.1.2.2.1 Search Field 

The search field allows the user to search through the library for a specific model code or part of a model 

code. When the search is launched from anywhere in the library, the search engine will close the search loop 

by restarting from the beginning. 
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3.1.2.2.2 Library Explorer 

The “Library Explorer” is a navigational tool. It allows the user to: 

• View different component categories; 

• Expand / Contract component categories. 

3.1.2.2.3 Component Selector 

The component selector allows the user to: 

• Visualize the component symbols; 

• Visualize the component description. If selected in the subfolder, the 

complete component description is shown;   

• The component selector allows the user to drag and drop a component onto 

the design area. (See the Working with Components chapter) 

  

Figure 3-2: Library 

3.1.2.2.4 Equivalent Products 

With HydraForce and Bosch components available in the library, two products may serve the same function. 

The preferred product is indicated and displayed first in search results. 

If a product is no longer available in the library but has an equivalent, the equivalent product is indicated. 
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Product equivalences can be viewed by opening the corresponding window using the highlighted command in 

the library. 

 

Figure 3-3: Product Equivalence in the Library 

 

3.1.2.3 Diagram Editor 

The diagram editor is the main part of the software. This interface is used for designing the symbolic view of 

the manifold design. It is composed of the following elements: 

• Drawing area; 

• Drawing tools; 

• CAD elements. 

Briefly, it allows the user to: 

• View the drawing area; 

• Activate the grid function; 

• Insert a Title Block; 

• Zoom in, zoom out and pan the drawing area; 

• Browse, select libraries and view components; 

• Insert components onto the drawing area; 

• Move, copy, cut, rotate and paste components on the drawing area; 

• Connect components; 

• Access specific component properties dialogs. 
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3.1.2.3.1 Drawing Area 

The drawing area is a white section onto which it is possible to design the desired system. Many tools and 

drawings aids are available while in this interface, primarily: 

• Page setup; 

• Grid function; 

• Zoom function. 

3.1.2.3.2 Default Page Setup 

The “Default Page Setup” dialog box can be accessed through the “i-CHoose” menu  → “Default Hydraulic 

Circuit Options” → “Default Page Setup”. It is used to specify the default page format for every new diagram. 

 

Figure 3-4: “Default Hydraulic Circuit Options” Menu 

 

The “Default Hydraulic Circuit Options” dialog box allows the user to select the default diagram size, 

orientation and units. 
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Figure 3-5: Hydraulic Circuit – Default Page Setup Dialog Box 

3.1.2.3.3 Current Page Setup 

The “Current Page Setup” is used to specify the dimensions of the diagram that is currently in use. It can be 

accessed: 

• Through the “Design” menu → “Settings” group → “Current Circuit 

Setup…”; 

 

Figure 3-6: Current Page Setup menu 

 

The “Current Page Setup” dialog box allows the user to select the current diagram size, orientation, and units.  

Note: These settings overwrite the ones specified in the “Default Page Setup”. 
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Figure 3-7: Current Page Setup Dialog Box 

3.1.2.3.4 Grid Function 

The grid is a series of perpendicular lines allowing the user to see the horizontal and vertical alignment of 

components. This function allows the user to align components to improve the clarity of the hydraulic circuit. 

To activate the grid: 

• Activate the “Grid” button in the “View” toolbar.  

 

Figure 3-8: Activated Grid Drawing Area 

3.1.2.3.5 Component Snap 

Component snap is used to keep all of the component connectors on a grid point. It is recommended to keep 

the snap mode active at all times to ensure the alignment of the components when placed on the drawing area. 

To activate the function, activate the “Component Snap” button in the View toolbar. 
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3.1.2.3.6 Zoom Functions 

The zoom functions are used to change the view of the drawing page. There are many zoom tools that can be 

used: 

• The zoom-in tool: 

1. Click on the “Zoom in”  button in the “View” toolbar to zoom into the drawing; 

OR  

2. Click on CTRL with +; 

OR 

3. Scroll with the mouse button. 

• The zoom-out tool: 

1. Click on the “Zoom out”  button in the “View” toolbar to zoom out of the drawing; 

OR  

2. Click on CTRL with -; 

OR 

3. Scroll with the mouse button. 

• The zoom box tool: 

1. Click on the “Zoom Selection”   button in the “View” toolbar to make it active; 

2. Make a box on the drawing space around the area you wish to zoom into.   

• The zoom-page tool: 

1. Click on the “Zoom Page”  button in the “View” toolbar; 

2. The grid and the component symbols are zoomed-out or in so that all of the components on the drawing 

area are visible. 

• The pan tool: 

1. Click on the “Pan”  button in the “View” toolbar; 

2. The mouse pointer takes the shape of a hand; 

3. Move the drawing area and all of the components on it by clicking and dragging the hand on the drawing 

area; 

4. De-select the tool by clicking on the icon again. 

OR  

5. Use the left mouse button and “Shift”, “Space Bar” key or the middle mousse button for the pan tool. 

3.1.2.4 Working with Components 

The first step in designing a system is to select and position components on the drawing area. This section 

details the following items: 

1. Dragging and dropping components onto the drawing area; 

2. Component representation on the drawing area; 

3. Selecting, deleting, copying, cutting, and pasting components; 

4. Rotating and moving components; 
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5. Accessing the component properties dialog box; 

6. Accessing a component’s contextual menu. 

3.1.2.4.1 Dragging and Dropping Components on the Drawing Area 

Once the desired component has been found in the component library, the user needs to follow these steps to 

insert it onto the drawing area: 

1. Select the image of the component in the bottom part of the library; 

2. Click and drag the component to the desired location on the drawing area; 

An image of the component is dragged along with the mouse pointer. 

If the component cannot be dropped at the position of the mouse 

pointer, the cursor changes to a prohibited symbol (circle with oblique 

bar).  

3. Release the mouse button. 

If the position is valid, the component stays in place and a purple 

rectangle (boundary box) with handle points surrounding the 

component is visible. 

The component appears in red. This means that it is not completely 

configured.   

The component ports appear in red until they get connected to other 

ports.  

Component labels (satellites) appear beside the symbol. The 

“Displayed Information” dialog box is used to choose what to display 

on the schematic. 

3.1.2.4.2 Selecting – Single Component 

To select a component: 

1. Click on the component. A selected component is enclosed in a purple boundary box. 

 

Figure 3-9: Selected Component on the Drawing Area 

3.1.2.4.3 Selecting – Window Selection 

To select multiple components using the selection window: 

1. Click and drag a rectangle on the drawing area while not in a tool mode (pan, zoom, line, etc.). 

Everything that is inside the selection box is then selected. 

 

Once multiple component selections are made, components can be: 

• Moved; 
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• Copied; 

• Deleted. 

 

Figure 3-10: Multiple Components Selection on the Drawing Area 

3.1.2.4.4 Deleting 

 To delete a component: 

1. Select the component or group of components; 

2. Click on the “Delete”   button in the “Design” toolbar; 

Or 

3. Press the DEL key; 

Or 

4. Open the contextual menu and select the “Delete” command. 

All links created from the component stay in place (see the linking components section). 

3.1.2.4.5 Copying 

To copy a component: 

1. Select the component or group of components; 

2. Click on the “Copy”   button in the “Design” toolbar; 

Or 

3. Press the CTRL+C keys; 

Or 

4. Open the context menu and select the “Copy” command. 

The component and all its attributes (properties, orientation, etc.) are sent to the clipboard. 

3.1.2.4.6 Cutting 

To cut a component: 

1. Select the component or group of components; 

2. Click on the “Cut”  button in the “Design” toolbar; 
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Or 

3. Press the CTRL+X keys; 

Or 

4. Open the context menu and select the “Cut” command; 

The component and all of its attributes (properties, orientation, etc.) are sent to the clipboard. The component 

is removed from the drawing area. 

3.1.2.4.7 Pasting 

To paste a component: 

1. Click on the drawing area at the location where you want to paste the component; 

2. Click on the “Paste”  button in the “Design” toolbar; 

Or 

3. Press the CTRL+V keys; 

Or 

4. Open the contextual menu and select the “Paste” command. 

Note: A component can only be pasted if it exists in the clipboard. 

3.1.2.4.8 Rapid Copy/Paste 

To accelerate the Copy/Paste function, press the CTRL key while moving a component. This will 

automatically copy the component to the new position. 

The mouse pointer changes to  when the CTRL key is used. 

3.1.2.4.9 Rotating 

To rotate a component: 

1. Select a component; 

2. Use the clockwise  rotation command in the “Design” toolbar; 

Or 

3. Use the counterclockwise  rotation command in the “Design” toolbar; 

Or 

4. Press on the CTRL+H rotation right shortcut keys on the keyboard; 

Or 

5. Press on the CTRL+L rotation left shortcut keys on the keyboard; 

Or 

6. Select the “Rotate Right” command from the contextual menu; 

Or 

7. Select the “Rotate Left” command from the contextual menu. 

The rotation of a component will rotate the symbol but not the satellite texts associated to it. 
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3.1.2.4.10 Flipping 

To flip a component: 

1. Select a component; 

2. Use the “Flip Horizontal”  command in the “Design” toolbar; 

Or 

3. Use the “Flip Vertical”  command in the “Design” toolbar; 

Or 

4. Press on the CTRL+T keys on the keyboard (Horizontal); 

Or 

5. Press on the CTRL+R keys on the keyboard (Vertical); 

Or 

6. Select the “Flip Horizontal” command from the contextual menu; 

Or 

7. Select the “Flip Vertical” command from the contextual menu. 

Flipping a component will flip the symbol but not the satellite texts associated to it. 

3.1.2.4.11 Moving 

To move a component:  

1. Drag and drop the component to a new position; 

Or 

2. Select the component and move it using the arrow keys.   

The same rules apply if a component is dragged from the “Library”. 

If links are attached to the component, the links remain attached when moving it. 

3.1.2.5 Context Menus 

To access contextual menus, right-click with the mouse in one of the following situations: 

1. Mouse pointer is on a hydraulic circuit component: 

 

Figure 3-11: Component Context Menu 



 i-CHoose User's Guide 

  

 3-14 

2. Mouse pointer is on an empty section of the hydraulic circuit area 

 

Figure 3-12: Empty Circuit Context Menu 

3.1.2.6 Viewing Component Properties 

To view component properties: 

3. Double-click on the component; 

4. Select the “Properties” command from the contextual menu of the selected item. 

See the “Component Properties” section of this manual for more details. 

3.1.2.7 Working with Graphical Elements 

Inserting a graphical element on the drawing area is similar to the insertion of a component. This action is 

done through the use of a drawing tool. Graphical elements can be stretched, copied, rotated, deleted and 

moved.   

 

Figure 3-13: Design-Drawing toolbar 

3.1.2.7.1 Inserting a Line, a Rectangle, and an Ellipse 

To avoid redundancy in the drawing function descriptions, only one graphical object’s drawing procedure is 

described below. 

 

To insert an ellipse: 

1. Select the “Ellipse”  button in the “Design” toolbar; 

2. Left-click on the diagram without releasing it and drag the cursor away; 

3. While dragging, the shape of the object appears and changes with the mouse movements; 

4. Release the mouse button when the object has reached the desired dimensions; 

The graphical object is displayed on the diagram. 

5. Repeat steps 1 to 4 for any other graphical object to insert it onto the diagram. 

3.1.2.7.2 Inserting a Text Box and a Picture 

To avoid redundancy, the following function description starts from the release of the left-click in the previous 

section. 

To insert a text box: 

1.  Repeat steps 1 to 4 of the previous procedure and ensure that the “Insert Text”  tool is selected in 

the “Design” toolbar; 

2.  In the entry box, type-in the text to include on the diagram. 
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To insert a picture: 

1.  Repeat steps 1 to 4 of the previous procedure and ensure that the “Insert Image”  tool is selected in 

the “Design” toolbar; 

The “Open” dialog box pops up. 

2.  Select the image you wish to insert onto the diagram; 

 Accepted formats are .JPG, .GIF, .PNG and .BMP. 

3.  Click on Open; 

The image appears on the diagram. 

3.1.2.7.3 Modifying Text Attributes 

To modify the text attributes: 

1. Double-click on the text to modify or select the “Properties” from its contextual menu; 

The “Font” dialog box for the text appears. 

2. Change the font of the text. Choices appearing in the list reflect the installed Windows fonts; 

3. Change the font style. The available styles are Windows standard: Bold, Italic and Bold Italic; 

4. Change the font size; 

5. Add text effects: Strikeout or Underline; 

6. Change the font color; 

7. Change the font script; 

 

Figure 3-14: Text Attributes Dialog Box 

 

The color selection is done through the “Color” dialog box: 
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Figure 3-15: Color Picker 

3.1.2.7.4 Modifying Graphical Element Attributes 

To change the outline of a graphical element: 

1. Select the element; 

2. Using the following buttons in the “Design” toolbar, define the line attributes of the element: 

 

Figure 3-16: Graphical Element Attributes 

 

The selection of colors is done through the use of a Windows standard color selector.  

 

The selection of the line type is done via a drop-down list.  

  

The selection of the line thickness is done via a drop-down list. 

 

Note: The color and thickness tools can be used to modify the valve symbols as well. 

 

3.1.2.8 Displaying Connection Port Names 

To display the port names of the components: 

1. Select the “View” toolbar → “View Connection Port Names”; 
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The port numbers will appear in a bubble. They cannot be moved or modified. 

2. To display a different port number, use the text tool to create a custom ID. 

3.1.2.9 Displaying Connection Ports 

To display the ports (small circles) on the components: 

1. Select the “View” toolbar → “View Connection Ports”. 

 

The ports will appear or disappear depending on their current state. 

3.1.3 Component Properties 

The “Component Properties” dialog box can contain four branches that are used to: 

• Component Configuration: 

o View the component description; 

o Select the component type; 

o View the component technical properties (ex: “Flow” and “Operating 

Pressure”) 

o View the component symbol; 

o Select specific options for the component; 

o View the current component “Model Code” (P/N); 

o View the “Material Number”; 

o View the coil information (if applicable) 

o View the component cavity name; 

• Displayed Information: 

o Select some component information to be displayed on the hydraulic circuit 

page; 

o Add a comment; 

o Edit the component label. 
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• Catalog Information: 

o View additional information on the component; 

o View the component PDF catalog file. 

 

To access the “Component Properties” dialog box: 

1. Double-click on the component; 

Or 

2. Select the “Properties” command from its contextual menu. 

 

Figure-3-17: Component Properties Dialog 

3.1.3.1 Selecting a Component Model 

Component model selection is the first step in the configuration of a component. Select the expected 

component model from this drop-down list field. This will update the component option fields as well as the 

“Model Code” number. 

3.1.3.1.1 Configuring the Component Model Code 

To configure the model code, select the desired options in each of the drop-down lists. Each component is 

defined as per the component specific attributes. 

Selection menus are dynamic, meaning that the contents of the drop-down lists will be consequential to the 

previous choices. 

If a default value for certain options has been defined in the “Project Properties” interface (seal, coil, 

termination), the drop-down lists will default to that value. However, these default values can be overwritten.  

Otherwise, the default value is a blank value which will normally be represented by “None” or “?”. 
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If a modification is made in an option field and it impacts another field, the second field is then automatically 

updated. 

 

Figure 3-18: Component Properties Dialog Box – Component Configuration 

3.1.3.1.2 Incomplete Component Model Codes – Component Display 

Components appear in red on the “hydraulic circuit” page when their “Component Properties” dialog has not 

been opened or if they have an incomplete model code due to a field that has been left blank in the component 

options. 

Furthermore, even if the user fills in all component option fields in the “Project Parameters” interface and a 

default model code is available for a component, that component will still appear in red as long as the user has 

not opened the “Component Properties” dialog box and clicked on the “Apply” button. 

The default color can be changed in the “Preferences/Options” i-CHoose menu. 
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Figure 3-19: Incomplete Component Color – Options Dialog 

3.1.3.1.3 Incomplete Component Material Number – Component Display 

Components that have an incomplete material number appear in blue on the “hydraulic circuit” page.  

 

3.1.3.2 Options Having an Impact on Component Symbol 

Some options selected in the drop-down lists will have an impact on the symbol that represents the component 

on the schematic. 

When one of these options is selected in the lists and the “Apply” button is clicked, the component symbol is 

automatically updated on the schematic to reflect these changes. 
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Figure 3-20: Component Symbol Selection – Configuration Window 

3.1.3.3 Component Identifier (ID) – Automatic Numbering 

The component “Identifier” is unique to each component on the drawing area. The software will automatically 

produce an ID for each component inserted on the diagram. 

Note: There is no check for “Component ID” uniqueness. The “Component Label” 

can be edited in the “Displayed Information” dialog box, but not the “Component 

ID”. The “Component ID” is a sequential number and will always take the value of a 

free number or increment to the next available one. 

A “Port Size” property is automatically added to the component and updated after changes are made in the 

"Component Configuration" dialog. The property is automatically positioned under the Component Id. 

3.1.3.4 Cavity Information 

For each component, a cavity is associated. Furthermore, the corresponding cavity will appear in the 

“Component Properties” → “Component Configuration” dialog box. 

3.1.3.5 Displayed Information 

The information listed in this dialog box is displayed on the diagram, but only if the box to the left of the field 

is checked. Standard information is displayed and positioned beside the symbol. The text displayed on the 

diagram can be moved but will always keep its position relative to the component if the component is moved. 

In other words, if the component is moved, the text boxes (satellites) move accordingly. 
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Figure 3-21: Component Properties Dialog Box – Displayed Information  

3.1.3.6 Catalog Information 

This section will bring up the PDF catalog page for the current component model. 

 

Figure 3-22: Component PDF Data Sheet 
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3.1.4 Creating a Design 

3.1.4.1 Connecting Components 

To connect components: 

1. Click on one of the symbol’s connection ports to define the starting point. The connection ports appear in 

red when a component is inserted onto the drawing area and is still not connected; 

The mouse pointer takes the shape of a cross.  

2. Each click, other than on another connection port, defines a new elbow in the link; 

3. Click on another port to create a connection. The link is established between the two components; 

Or 

4. Double-click where there is no connection port on the diagram. The link will end at the point where the 

double-click occurred and the link will have a connection port at its end. 

The mouse pointer reverts to its initial shape once the link is completed, as described in steps 3 and 4. 

3.1.4.1.1 Modifying a Connection Line (Link) 

To modify the shape of a link: 

1. Select the link that will be modified; 

The link is highlighted in the selection color and handles are displayed along it. 

2. Click and hold the mouse button on one of the link handles; 

The mouse cursor takes one of the following shapes depending on the selected handle ,  or . 

3. Drag the cursor to modify the link path; 

 

Figure 3-23: Modifying the Shape of a Link 

 

4. Release the mouse button. 

The link is modified. 

The mouse pointer reverts to its initial shape. 

3.1.4.1.2 Select Path (Highlight Path) 

The "Highlight Path" feature, accessible via the context menu by right-clicking on a connection line, allows 

you to select all interconnected connection lines. 



 i-CHoose User's Guide 

  

 3-24 

 

Figure 3-24: Highlight Path 

 

3.1.4.1.3 Link Crossing Jump and Connection 

When two links cross each other without connecting, a line jump will appear on one of the two lines.  Two 

links that connect to each other will do so with a connection point (black dot). 

   

Figure 3-25: Line Jump and Line Connection 

3.1.4.1.4 Configuring a Connection Line 

3.1.4.1.4.1  Configuring the Default Appearance of a Connection Line 

The default appearance of each line can be changed in the “Preferences/Options” of the application. See the 

“Preferences/Options” Chapter. 

The possible line types are: 

Line type Default Appearance (Example) 

Pressure Solid Black Line 

Pilot Short Dashed Black Line 

Drain Short Dashed Black Line 

Return Long Dashed Black Line 

Load sense Long Dashed Black Line 

Custom Solid Black Line 

The custom line is a special case; its default appearance can be modified from the toolbar. The first time the 

application is launched, its default value will be the same as the pressure line. The custom line keeps the last 

configured changes. 
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The other line types can be modified as well. In this case, information will be added to the name of the type to 

indicate that the default value has been modified. Example: Pressure Line (Modified) 

3.1.4.1.4.2  Modifying a Connection Line from the Toolbar 

 

 

Figure 3-26: Modifying a Connection Line 

3.1.4.1.4.3  Connection Line Modification Behavior 

 

 

Figure 3-27: Predefined vs Custom Connection Line 

The users can choose among predefined and custom connection lines when they draw the schematic. 

Predefined connection Lines 

The “usual” connection lines are predefined in the “Options” dialog (Preferences menu): 

- Pressure Line 

- Drain Line 

- Pilot Line 

- Load Sense Line 

- Return Line 

Custom Connection Line 
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The user can use a specific configuration (Color, Style and Thickness) using a “Custom Line”. In this case, 

they can change the color, the style and the thickness from the toolbar. 

 

3.1.4.1.4.4 Use Case 1: Select the Connection Line Type before drawing it (No connection line selected 

on the schematic) 

If no connection line is selected on the schematic, the drop-down list displays the current connection type 

(which will be used for each new connection line). The user can change the current line type by selecting a 

different type in the list. 

 
Figure 3-28: Predefined Connection Line 

The three buttons used to modify the color, style and thickness are enabled. If one of these predefined values 

is modified (and different), a text appears near the line type in the drop-down list. 
 

 

Figure 3-29: Modified Predefined Connection Line 

If a predefined type is selected in the drop-down list, and if the color, style or thickness is modified with the 

same value, the predefined type is still selected.  

The values selected in the drop-down list will be used for each new connection line drawn on the schematic. 

 

3.1.4.1.4.5 Use Case 2: Modify an existing Connection Line Type on the schematic 

If one or more connection lines are selected, the type field displays the type of the selected connections. If 

there are different connection types in the selection, the type field will be empty. 

If one or more connection lines are selected, the user can change the type of the selected connections by 

selecting a different value. 

If one or more connection lines are selected, the user can change the color, style and thickness. 

If a predefined type is selected in the drop-down list, and if the color, style or thickness is modified with the 

same value, the predefined type is still selected.  
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3.1.4.1.4.6 Use Case 3: Behavior when a project is open 

When a project is opened, it uses the “Predefined values” of the user to draw the predefined connection lines. 

Example: If a project is created on computer1 using some black predefined pressure lines, the color of the 

connection lines will be black. If the project is open on another computer2 with red predefined pressure line, 

the connection lines will be displayed in red. 

 

3.1.4.1.4.7 Configuring a Connection Line from the Contextual Menu 

As different line types exist in the hydraulic circuit design, it is possible for the user to select the different line 

types from the line contextual menu (right click on the line). This will allow the user to represent the lines 

differently on the schematic. 

This line type change only modifies the selected connection lines.   

 

Figure 3-30: Selecting Line Type 

3.1.4.2 Creating a System Boundary 

The “System Boundary”, or manifold border, is used to define the limits of the manifold in a circuit diagram. 

To create a manifold border: 

1. Select the “System Boundary” component from the “Library”; 

2. Drag and drop the “System Boundary” anywhere onto the drawing area; 

3. Using the handles, stretch the border to the desired size, encompassing all components that are included 

on the manifold block.  

 

Figure 3-31: Manifold Border 
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3.1.4.3 Adding Ports to the Manifold 

The manifold ports are components used to define the connections that will appear on the manifold once it has 

been completely designed.   

To insert a port: 

1. Select the “Connection Port” component from the “Library”; 

2. Click and drag the port onto the drawing area; 

3. Double click on the “Connection Port” or select “Properties” from its contextual menu.  

4. In the “Component Configuration” branch, enter the “Component Options”. 

Note: Each “Port” inserted on the hydraulic circuit diagram will appear in the 

“Manifold Library” used in the 3D manifold layout interface. 

 

Figure 3-32: Connection Port Component Properties 
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3.1.5 Manifold Layout Interface 

The manifold layout interface is used to physically position the components on the manifold block faces. The 

component representations shown in the interfaces are realistic. The component sizes and shapes are 

represented as envelopes that need to be taken into consideration when positioned.  

The interface contains two major parts: 

1. The “Manifold Library”; 

2. The “Manifold Layout” editor; 

The “3D Manifold Layout” interface is an isometric view of the manifold block. It can be rotated to view each 

of its faces. 

 

Figure 3-33: 3D Manifold Layout Interface 

 

3.1.5.1 Manifold Layout Library 

The “Manifold Library” uses the same interface as the “Hydraulic Circuit Library”. Differences lie in the 

components that populate the library. Three major component categories are included in this library: 

1. Manifold Ports; 

2. Components; 

3. Mounting Holes; 

The “Manifold Library” is automatically populated with components that have been inserted on the 

“Hydraulic Circuit” page. 

3.1.5.1.1 Manifold Ports 

The manifold ports are the same “Connection Ports” that have been inserted and configured in the “Hydraulic 

Circuit” interface. In the “Library”, they are identified by the same identifier that is defined in the “Hydraulic 

Circuit” interface. 



 i-CHoose User's Guide 

  

 3-30 

 

Figure 3-34: Manifold Layout Library 

3.1.5.1.2 Manifold Components 

Components found in the “Components” section of the “Manifold Library” are taken directly from the 

“Hydraulic Circuit” interface. Their identifiers are the same as the ones defined in the “Hydraulic Circuit” 

interface. 

 

Figure 3-35: Component in the Manifold Layout Library 

3.1.5.1.3 Mounting Holes 

Mounting holes do not appear in the “Hydraulic Circuit” interface. Only one component appears in the 

manifold library. That component can be inserted onto the manifold block as many times as required. 

3.1.5.2 Manifold Layout Editors 

The 3D manifold layout editors are used to position the various components on the manifold block. They are 

required to define the physical parameters of the manifold. 
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3.1.5.2.1 Manifold Layout Editor – Inserting Ports 

The insertion of “Ports” is the same as the insertion of other components in the “Hydraulic Circuit” interface. 

The component can be dragged and dropped from the “Manifold Library” onto one of the manifold surfaces. 

The positioning and manipulation of components and satellite texts follow the same rules as for the hydraulic 

circuit interface. The size and identifier that are defined for the “Port” automatically appear beside it. 

3.1.5.2.2 Manifold Layout Editor – Deleting Ports 

 Deleting “Ports” is done in one of the two following ways: 

1. Select the “Port” and press the “Delete” key; 

2. Select the “Delete” command from the component contextual menu. 

The deleted port will return to the “Manifold Library” and be available for re-insertion. 

3.1.5.2.3 Manifold Layout Editor – Managing Ports 

If a port is deleted in the hydraulic circuit interface, the corresponding port is also deleted in the manifold 

layout editors. 

If a port’s ID is changed in the hydraulic circuit interface, the corresponding port is renamed in the manifold 

layout interfaces. 

A port cannot be pasted/copied in the manifold layout editors. 

3.1.5.2.4 Manifold Layout Editor – Inserting Components 

The insertion of components in the “Manifold Layout” editors is done in the same way as in the “Hydraulic 

Circuit” interface. To insert a component, drag and drop it onto one of the manifold faces. The component can 

only be dropped if it is on one of the manifold faces. 

3.1.5.2.5 Manifold Layout Editor – Component Management 

If a component is deleted from the hydraulic circuit interface, the corresponding component is also deleted 

from the manifold layout editors. 

If a component label is changed in the hydraulic circuit interface, the corresponding component is renamed in 

the manifold layout interfaces. 

A component cannot be pasted/copied in the manifold layout editors. 

3.1.5.2.6 Manifold Layout Editor – Inserting Mounting Holes 

The “Mounting Hole” component is only available in the “3D Manifold Layout” library . 

The insertion is done in the same way as for the other ports and components. The “Component Properties” 

dialog box is then used for proper configuration. 

To access the “Component Properties” dialog box, double-click on the “Mounting Hole”. 
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Figure 3-36: Mounting Hole Component Properties Dialog Box 

 

3.1.6 Manifold Manipulations 

3.1.6.1 Faces Labels 

Each block face has a stamped label name (Front, Back, Top, Bottom, Left or Right) 

3.1.6.2 Zoom 

The user can zoom in and out by using the mouse scroll or the zoom functions in the “View” toolbar. 

If the mouse wheel is used, the zoom is focalized on the center of the mouse. 

3.1.6.3 Pan 

The user can use the panning function in the “View” toolbar to move the view in any direction. 

The other method is to click and drag the mouse while holding the spacebar on the keyboard. 

When the “Pan” mode is activated, the cursor changes with the following image: 

 

3.1.6.4 Rotate 

The user may rotate the 3D view by using the wheel button in the 3D view and moving the mouse around. 

Another method is to click and drag the mouse while holding the shift key on the keyboard. 

The “Rotate Block” tool in the “Design” toolbar can also be used to rotate the manifold block. 

When the “Rotate Block” mode is activated, the cursor changes with the following image: 

 

When using the “Rotate Block”, a click and drag action on the manifold will then rotate the view. 

The ESC key cancels the “Rotate Block” mode, and return to the “Select” mode. 
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3.1.7 Manifold View 

The 3D manifold view may be configured in several ways. This section describes how to activate the 

following views: 

▪ Transparency; 

▪ Components; 

▪ Component Label; 

▪ Leader; 

▪ Interferences; 

▪ Reference Axis; 

▪ Manifold Grid. 

▪ Dimensions; 

▪ Placement Locks. 

3.1.7.1 Transparency 

The 3D Manifold Layout interface may be configured to be visualized in a solid/opaque view, a transparent 

view or an invisible view (Only displays components). 

 

Figure 3-37: Transparent vs. Solid Views 

 

Change the transparency setting by clicking on the Transparency drop-down list in the “View” toolbar. 

 

Figure 3-38: Transparency Options 
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3.1.7.2 View Components 

The 3D Manifold Layout interface may be configured to display only the cavity portion of the components. By 

default, the complete components are displayed. 

 

Figure 3-39: View of the Complete Components vs. the Cavities Only 

 

Change the “Components” setting by clicking on the “Components” button in the “View” toolbar.  

 

Figure 3-40: View Cavities Only Option 

3.1.7.3 View Component Label 

The 3D Manifold Layout interface may be configured to display/hide the component labels. By default, the 

component labels are displayed. 

Change the “Component Label” setting by clicking on the “Component Label” button in the “View” toolbar.  

 

 

Figure 3-41: View Components Label Option 

It is possible to configure the identifier font by double-clicking on each of them. The identifiers can also be 

moved around by selecting and dragging them. 
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3.1.7.4 View Satellite Owner 

The 3D Manifold Layout interface may be configured to display/hide a line going from the components to 

their identifiers. By default, the line is not displayed. This is useful to easily figure out which identifier goes 

with each component. 

 

Figure 3-42: Lines Showing the Owners of the IDs 

To display/hide the lines, select the “Leader” command in the “View” menu. 

 

Figure 3-43: View Leader Option 

Note: The reference lines will follow the corresponding IDs when they are moved. 

3.1.7.5 View Interferences 

The 3D Manifold Layout interface may be configured to display/hide the physical cavity interferences in red. 

By default, the interferences are displayed. 

  

Figure 3-44: Component Interference 
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Change the “View Interferences” setting by clicking the “View Interferences” command in the “View” menu. 

 

Figure 3-45: View Interferences Option 

3.1.7.6 View Reference Axis 

The 3D manifold interface may be configured to display/hide the XYZ axis at the (0, 0, 0) coordinate. 

  

Figure 3-46: Reference Axis 

There are two ways to display/hide the reference axis: 

3. By selecting the “View Reference Axis” command in the “View” menu; 

 

Figure 3-47: View Reference Axis 

4. By right-clicking on one of the manifold faces and selecting “Display Reference Axis” in the contextual 

menu. 
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Figure 3-48: Display Reference Axis in the Contextual Menu 

3.1.7.7 Manifold Grid 

The grid properties can be configured for the 3D manifold interface. The unit defined when the project was 

created is used. 

 

Figure 3-49: Manifold Layout Grid Properties Dialog Box 

 

Figure 3-50: Manifold Layout Grid 
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To open the “Manifold Grid Properties” dialog box, select it in the “Design” menu→ “Block” group. 

 

Figure 3-51: Manifold Grid Properties Command 

Notes: Do not forget to activate the “View Grid” option in the “Preferences” menu to 

see the grid lines. 

3.1.7.8 Flat View 

In the 3D interface you have the “Flat” view. To rapidly go to a “Flat” view, double-click on the desired face. 

To see the isometric view after activating the flat view, simply rotate the manifold by pressing on the wheel 

button and moving the mouse in the main display. 

 

Figure 3-52: 3D Front Face in Flat View 

3.1.8 Manifold Component Configuration 
 

Once a component has been inserted onto a manifold face, the user can modify various parameters to their 

exact specifications. The following configurations can be applied: 

▪ Set Custom Component Dimension; 

▪ Set Component Location; 

▪ Rotate and Move Components; 

▪ Lock Component Position; 
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▪ Restrict Component to Surface; 

▪ Counterboring; 

The description of how to assign notes to a manifold face is also at the end of this section. 

3.1.8.1 Set Custom Cartridge Dimension 

It is possible to position “Custom” cartridges on the manifold block. Custom cartridges have unknown 

dimensions and shapes that need to be specified. To do this: 

1. Insert the custom cartridge from the library onto one of the manifold faces; 

2. Right click on it and select “Set Dimensions…” from the contextual menu; 

 

Figure 3-53: 3D Set Dimensions from its Contextual Menu 

3. Select the envelope shape in the dialog box; 

4. Enter the dimensions of the component. 
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Figure 3-54: Custom Component Envelop Dimensions 

Note: Cavity envelope shapes and sizes will be used to signal interferences with 

other cavities or the manifold edges. 

3.1.8.2 Set Component Location 

Components can be moved in three different ways: 

1. By selecting a component and dragging it with the mouse on any of the manifold faces; 

Note: The movement is restricted to one face if more than one component is 

selected at a time. 

2. By selecting a component and using the keyboard arrows to move it. The component movement is 

restricted to its current face. This works only in the “flat” view; 

3. By right clicking on the component and selecting “Set Location” in its contextual menu. 
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Figure 3-55: Set Location Command 

 

• From the “Design” toolbar 

 
 

Then enter the X, Y, Z position coordinates in the dialog box that opens. These coordinates are relative to the 

origin point shown by the reference axis. (See View Reference Axis section for more details) 

 

Figure 3-56: Set Location X, Y, Z Fields 

Note: The coordinates must be on the same face where the component is 

currently located. This is the reason why there is one coordinate that cannot be 

edited. 

3.1.8.3 Rotate a Component 

Components and accessories can be rotated so that the user can optimize the manifold block space. To do this: 

1. Right click on the component to select it and display its contextual menu. 

2.  Select the “Set Angle” command; 
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Figure 3-57: Set Angle Command 

3. Type in the desired angle in the “Component Angle” dialog box; 

 

Figure 3-58: Component Angle Dialog Box 

4. Click on “OK”. 

The manifold layout views are immediately refreshed to display the new angle of the modified component. 

The “Rotate Left” and “Rotate Right” tools in the “Design” toolbar can also be used to quickly rotate the 

selected component by 45 or 90 degrees counter-clockwise or clockwise. The angle used depends on the 

selected component.  

3.1.8.4 Lock Component Position 

If a component position is a constraint for the block manifold design, the user can lock the component position 

so that it cannot be moved or displaced afterward. 

There are three ways to lock the position of a component on the manifold: 

1. By using the “Lock Position”  button in the “Design” toolbar; 

2. By right clicking on a component and selecting “Lock Position” in the contextual menu; 
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Figure 3-59: Lock Position Command 

3. By right clicking on a component and selecting “Set Location” in the contextual menu. 

Then select the “Lock Location” radio button in the “Constraint” area of the “Set Location” dialog box. 

 

Figure 3-60: Lock Location Radio Button 

Note: To unlock the component position, select the “None” radio 

button in the “Constraint” area of the “Set Location” dialog box. 

A green pin  is displayed over the component in the manifold views to indicate that it cannot be relocated.  

 

3.1.8.5 Restrict Component to Surface 

If a component position is restricted to a face of the block manifold design, the user can restrict the component 

position so that it cannot be moved outside of the selected face. 

There are several ways to restrict the position of a component on the manifold: 

1. By using the “Lock on Current Face”  tool in the “Design” toolbar; 

2. By right-clicking on a component and selecting “Lock on Current Face” in the contextual menu. 
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Figure 3-61: Lock on Current Face Command 

3. By right clicking on a component and selecting “Set Location” in the contextual menu. 

Then select the “Lock on Current Face” radio button to activate the constraint. 

The “Preferred Faces” choice is only used for documentation purposes. The software will not restrict the 

component location in this case. To do this, select the “Preferred Faces” radio button instead. Then add the 

preferred faces to the list going from 1st to 6th.  

 

Figure 3-62: Preferred Faces Defined in Set Location Dialog Box 
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A blue pin  is displayed over the component in the manifold views to indicate that it is restricted to the 

current face.  

A yellow pin  is displayed over the component to indicate that it is restricted to several faces.  

3.1.8.6 Counterboring 

After being placed on an orthogonal projection or on one of the isometric view faces, a valve can be sunk into 

a counterbore. To create a counterbore: 

1. Right-click on a component in a manifold layout interface; 

2. Select “Counterboring” in its contextual menu; 

 

Figure 3-63: Counterboring Command in the Contextual Menu 

3. Configure the depth and the diameter of the desired counterbore for this component. 

 

Figure 3-64: Counterbore Dialog Box 
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3.1.8.7 Reversing a Component 

Some components are bi-directional and symmetric. The flow can travel in 2 directions. In this case, the 

designer can reverse the component in order to simplify the routing solution. Port 1 will become Port 2 and 

vice versa. 

 

Figure 3-65: Reversible Components 

1. Right click on the component in the schematic or on the 3d layout and select “Flip Reversible 

Component” from the contextual menu; 

 

Figure 3-66: Flip Reversible Component Option 

3.1.8.8 Assigning Notes to the Manifold Faces 

Notes can be added to each face of the manifold block. To create a note: 

2. Right click on the faces where you want to add the note; 

3. Select “Set Note” in the contextual menu; 

 

Figure 3-67: Set Note Command in the Manifold Face Contextual Menu 

4. Type in the note; 
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Figure 3-68: Set Note Dialog Box 

5. Configure the desired text font by clicking on the “Font” button. 

A note is now displayed below the face in the “flat” view. 

 

Figure 3-69:  Note Added to the Manifold Front Face 
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3.1.9 Manifold Dimensioning 

When a new project is created, the manifold has predefined dimensions. You can read the current extrusion 

size and the length in the status bar. 

 

Figure 3-70:  Extrusion Size and Length in the Status Bar 

There are three ways to modify the block manifold size: 

▪ By dragging face edges; 

▪ By using the “Dimensions” dialog box; 

▪ With automatic shrinking. 

3.1.9.1 Resizing by Dragging the Edges 

Modification to the manifold dimensions can be done by dragging the edges. Depending on the dragged edge, 

the dimension change will be done on the length or the extrusion. To do this: 

1. On the 3D Manifold Layout document, double-click on a face to display it in “Flat mode”. 

2. Activate the resizing mode by clicking on the “Show Resize Handles” tool  in the “Design” toolbar.  

Selection boxes with handles will appear on the manifold layout interface; 

 

Figure 3-71:  The Manifold Layout Interface in Resizing Mode 

3. Grab one of the handles, which are the little squares on the selection lines around the faces, and drag it 

with the mouse. 

4. Repeat the dragging of the edges until you obtain the desired size. 

Notes: When dragging a manifold edge, the extrusion will increase or decrease to the 

next standard size. 
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3.1.9.2 Resizing through the Dimensions Dialog Box 

The manifold dimensions can be modified from the “Dimensions” dialog box by selecting the “Design” menu 

→ “Block Dimensions…”. 

 

Figure 3-72:  Set Manifold Dimensions… 

This opens the “Manifold Dimensions” dialog box that can be used to precisely resize the extrusion and the 

length of the manifold block. 
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Figure 3-73:  The “Manifold Dimensions” Dialog Box 

To resize the extrusion: 

1. Select the desired “Extrusion Size” from the predefined list; 

2. Select the direction in which resizing should be done by checking the corresponding boxes; 

If two opposed extrusion checkboxes are selected, then resizing is done symmetrically in the two directions. 

Otherwise, it will only be done in the checked direction. 

If two opposite directions are unchecked, the “Extrusion Size” drop-down list will only display options using 

the current dimension for this side. 
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Note: The available extrusion sizes in the drop-down list depend on the component 

envelopes inserted on the manifold block. 

To change the manifold length: 

3. Enter the desired value in the “Length” field; 

4. Select the direction in which resizing should be done by checking the corresponding “Length” boxes; 

If both extrusion checkboxes are selected, then resizing is done symmetrically in the two directions. 

Otherwise, it will only be done in the checked direction. 

Note: The minimum length permitted, displayed at the right of the “Length” field, 

depends on the component envelopes inserted on the manifold block. 

3.1.9.3 Automatic Block Compaction 

The “Compact Block” function automatically finds the minimum extrusion size and length by closing each 

manifold face until cavity envelope interferences are detected. 

To automatically compact the manifold dimensions, click on the “Compact Block” tool in the “Design” tab → 

“Block” group.  

3.1.10 Parts List Interface 

The part list interface is a simple BOM of the current design. It displays the information of the components 

that have been inserted and configured in the hydraulic circuit interface. 

This list can be copied and pasted into any Microsoft compatible spreadsheet application. 

 

Figure 3-74: Parts List Interface 

All of the information found in the part list interface is defined in the “Component Properties” dialog box. 

3.1.11 Technical Data Interface 

The technical data interface is a summary table of the project and component parameters. The table is divided 

into multiple sections: 

▪ TECHNICAL DATA 

▪ ELECTRICAL CHARACTERISTICS COIL 

The technical data section displays information from the project parameters. 

The electrical characteristics coil section displays the information of the components containing coils that 

have been inserted and configured in the hydraulic circuit interface. The same coils are grouped in one table 

section. If there are other different coils, new ELECTRICAL CHARACTERISTICS COIL tables are added. 
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This whole table contains the following columns: 

▪ Parameter Name 

▪ Value  

▪ Button to Override the Value (Only visible in PRO version) 

▪ Button to Display the data in the Technical Drawing (Only visible in PRO version) 

 

A blank row makes it possible to input other parameters (Only in PRO version). 

A blank row makes it possible to input other parameters in the electrical area (Only in PRO version). 

This table can later be reused from the library as an element on the technical drawing. 

All the original values are displayed on the gray background and cannot be modified.  

 

Figure 3-75: Technical Data Interface 

In the PRO version, icons beside each parameter entry are used to override the values or to display the 

parameters on the Technical Drawing. If a value is overridden, the background of the text is white. 

 

3.2 Creating a Compact Directional Valve Project (CDV) 
The principle is similar to that of a HIC project. See the “Creating a Manifold Project” chapter for the complete 

detailed information. 

However, some specific cases apply for a CDV project. These differences are described hereafter. 
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3.2.1 Project Parameters Interface 

The only differences compared to a HIC project concerns the mounting bracket and spacer options.  

 

Figure 3-76: Mounting Brackets 
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3.2.2 Creating a Hydraulic Circuit 

The behavior is the same as for a HIC project except for the 3D interface. (See “Creating a Hydraulic Circuit” 

for HIC project). 

For a CDV project, the components are automatically placed on the 3D view. No manipulation is allowed 

except for some items such as accessories, coil rotation, etc... 

The properties dialog opens by double-clicking on the element. 

 

3.2.2.1 Accessories and fixation elements 

 

The following accessories are automatically placed on the 3D view and will be listed in the report too. 

• Assembly of directional elements 

For 1 or 2 elements, the assembly kit is composed of 3 screws and 3 washers. 

 

For 3 or more elements, the assembly kit is composed of 3 tie-rods, 3 washers and 3 

nuts. 

 

• Assembly of flangeable elements 

The assembly kit is composed of 4 screws and 4 washers. 

 

 

• Fitting of mounting brackets 

The kit is composed of 2 brackets, 4 screws and 4 washers.  
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The Mounting Brackets are not automatically added to the assembly. To add 

Mounting Brackets to the project, select them in the Project Parameters page. 

 

• Kit for spacer between elements 

The spacers are fitted in order to install longer tie-rods for the future insertion of an 

extra directional element.  

The spacer is not automatically added to the assembly. The user has to open the 

properties dialog of the screw and then, select “Spacer”. The spacer will appear on 

the 3D view and in the report. 

 
 

• Flow restrictors 

The flow restrictors are placed in a port between elements (for example). 

Additionally, they can be used to close a port. 

These components are available in the library and must be inserted in the hydraulic 

circuit page as shown in the following example: 

 



 i-CHoose User's Guide 

  

 3-56 

 

3.2.3 CDV Layout Interfaces 

 

The CDV layout interface is used to visualize the components. The component representations shown in the 

interfaces are realistic. 

This is the 3D CDV Layout interface. 

 

Figure 3-77: 3D CDV Layout Interface 
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3.2.4 CDV Layout Manipulations 

The following functionalities are available for the 3D CDV Layout interface. 

3.2.4.1 Zoom 

The user can zoom in and out by using the mouse scroll or the zoom functions in the “View” toolbar. 

If the mouse is used, the zoom is focalized on the center of the mouse. 

3.2.4.2 Pan 

The user can use the panning function from the View toolbar to move the whole view in any direction. 

The other method is to move the mouse while holding the spacebar on the keyboard. 

When the “Pan” mode is activated, the cursor changes to the following image: 

 

3.2.4.3 Rotate 

The user may rotate the 3D view by using the wheel button in the 3D view and moving the mouse around. 

Another method is to move the mouse while holding the shift key on the keyboard. 

The “Rotate Block” tool in the “Design” toolbar can also be used to rotate the manifold block. 

When the “Rotate Block” mode is activated, the cursor changes to the following image: 

 

When using the “Rotate Block”, a click and drag action on the manifold will then rotate the view. 

The ESC key cancels the “Rotate Block” mode, and return to the “Select” mode. 

3.2.4.4 Explode 

The user may separate (explode) all the elements by holding the ctrl + shift key on the keyboard and using the 

mouse scroll wheel. 

The user may separate all the elements by moving the following cursor in the toolbar  . 

 
Figure 3-78: 3D CDV Exploded View  
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3.2.5 Insert a HIC Manifold in a CDV Project 

You can insert a HIC manifold into a CDV Project. Use the “Import a HIC Project” command available in the 

“i-CHoose – Import / Export” menu. An “open file” dialog opens where the HIC project can be selected. The 

HIC schematic will be inserted onto the schematic as a group of components 

 

 

Figure 3-79: Insert a HIC in a CDV Project 

 

Note: The HIC project must be compatible with a CDV project. For example, the 

external connections of the manifold must have compatibles flanges. Contact Bosch 

Rexroth for more details. 



 i-CHoose User's Guide 

  

 3-59 

3.3 Creating a Compact Power Module Project (CPM) 

The principle is similar to that of a CDV project. See the “Creating a Compact Directional Valve Project” chapter 

for the complete and detailed information. 

However, some specific cases apply to a CPM project. These differences are described hereafter. 

3.3.1 Project Parameters Interface 

The main differences when compared to an HIC project are listed below: 

• Relief Valve Pressure Setting (Mandatory) 

• Operating Pressure 

• Motor Type (Mandatory) 

• Required Flow (Mandatory) 

• Motor Power (Mandatory) 

o Help button: To get motor power theoretical calculations 

• Mounting Position (Mandatory) 

• Useable Tank Capacity (Mandatory) 

o Help button: To get information in order to calculate tank capacity 

• Add Mounting Bracket (Mandatory) 

• Max Overall Dimensions 

o Help button: To get information in order to specify the maximum 

acceptable overall dimensions 

• Ambient Type (Mandatory).  

 

Figure 3-80: Technical Information 
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3.3.2 Creating a Hydraulic Circuit 

The behavior is the same as for a CDV project. (See “Creating a Hydraulic Circuit” for CDV project). 

For a CPM project, the components are automatically placed on the 3D view. No manipulation is possible 

except for some items such as accessories, coil rotation, etc... 

The properties dialog opens by double-clicking on the element. 

3.3.2.1 Library Specificities 

 

The library in a CPM project includes more features than the library available for an HIC or a CDV project. 

In a CPM project, the library automatically highlights the compatible central manifolds based on the “Project 

Information”, such as the “Application” and the “Function” selected to guide the user in its selection. 

Additionally, the library contains “Main Realizable Diagrams” which are predefined/preconfigured central 

manifolds from which the user can start. 

A mouse-over a central manifold pops-up a larger preview. 

Another particularity is the central manifold itself, which is in fact a complete power module assembly 

containing the central manifold in the upper section and the motor, the pumps, the tank and the pipes in the 

lower section. 

 

Figure 3-81: Library Specificities 
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3.3.2.2 CPM Configuration 

 

The starting point of a CPM project remains the completion of the “Project Parameters” document like in an 

HIC or a CDV project. However, in a CPM project, some information in the “Project Parameters” document is 

used to guide and facilitate the central manifold selection. Additionally, once the central manifold is brought 

into the “Hydraulic Circuit” from the library for the first time, some of the technical parameters are transferred 

into the current central manifold. For these reasons, starting from the “Project Parameters” document is much 

more important in a CPM project. 

The next step is to select a central manifold from the library and drag and drop it onto the “Hydraulic Circuit” 

document. This is the core of a CPM project. In fact, as previously stated, the central manifold is a complete 

power module representation. 

The configuration process starts after the central manifold is placed on the schematic. Double-clicking on the 

central manifold opens the configuration window which contains all the elements of the power module. 

The configuration window lists all the elements of the power module in a logical order to complete the 

configuration process. It starts with general parameters (relief valve setting pressure, required flow, mounting 

position, etc.) which are usually transferred from the “Project Parameters” document, then the motor, the 

pump, the junction element, the central manifold built-in valves … all the way down to the pipes. 

The configuration process is loaded with design rules, element compatibility and automatic element selection 

which make the configuration easy and errorless every time. 

 

Figure 3-82: Configuration Window 
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3.3.2.3 Modular Stackable Elements 

Like in a CDV project, stackable modular elements can be added to the central manifold hydraulic circuit to 

complete the system. However, these elements have interfaces which determine whether or not they are 

compatible with each other. If they are compatible, they are automatically shown in the 3D Layout in the 

correct physical location and will also be listed in the report. 

3.3.2.4 Accessories 

Accessories like the isolator, pressure gauge or switch and plug can be inserted on any compatible port on the 

schematic. If they are compatible, they are automatically shown in the 3D Layout in the correct physical 

location and will also be listed in the report. 

3.3.2.5 Fixation Elements 

Like in a CDV project, all the bolts, the screws and the assembly kits are automatically shown in the 3D 

Layout in the correct physical location and will also be listed in the report. 

3.3.3 CPM Layout Interfaces 

The CPM layout interface is used to visualize the components. The component representations shown in the 

interface are realistic. 

Following is the 3D CPM Layout interface. 

 

Figure 3-83: 3D CPM Layout Interface 
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3.3.4  CPM Layout Manipulations 

The features in the CPM 3D Layout document are the same as in a CDV project. 

3.3.4.1 Transparency 

The user can make an element transparent to view the internal arrangement by right-clicking on the element 

and by selecting “Set Transparent” from the contextual menu. 

 
Figure 3-84: CPM Transparent Element  

3.3.5 Insert a HIC Manifold in a CPM Project 

You can insert a HIC manifold in a CPM Project. Use the “Import a HIC Project” command available in the 

“i-CHoose – Import / Export” menu. An “open file” dialog opens where the HIC project can be selected. The 

HIC schematic will be inserted on the schematic, as a group of components 
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Figure 3-85: Insert a HIC in a CPM Project 

 

Note: The HIC project must be compatible with a CPM project. For example, the 

external connections of the manifold must have compatibles flanges. Contact Bosch 

Rexroth for more details. 

3.3.6 Insert a CDV Assembly in a CPM Project 

You can insert a CVD assembly in a CPM Project. Use the “Import a CDV Project” command available in the 

“i-CHoose – Import / Export” menu. An “open file” dialog opens, so the user selects the CDV project. The 

CDV schematic will be inserted on the schematic as a group of components 
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Figure 3-86: Insert a CDV in a CPM Project 

 

Note: The CDV project must be compatible with a CPM project. For example, the 

CDV assembly must contain the compatible adaptor plate. Contact Bosch Rexroth 

for more details. 
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3.4 Revision History  

 

The “Revision History” dialog box is used to track the changes made to the manifold design project.  

In this section we will: 

1. Describe how to access the “Revision History” dialog box; 

2. List the available fields; 

3. Create and view revisions. 

3.4.1 Accessing the Revision History  

There are several ways to access this dialog box: 

1. Through the “Revision” command in the “i-CHoose - Project” menu; 

 

Figure 3-87: Revision in the File Menu 

2. By right clicking on the project name in the “Project Explorer” window and selecting “Revision” in the 

contextual menu; 
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Figure 3-88: Revision in the Project Explorer Context Menu 

3. By clicking on the “Revision” button in the “Project Parameters” interface; 

 

Figure 3-89: Revision Button in the Project Parameters Interface 

4. When the project has a revision history and is saved as a new project, the “Revision History” dialog box 

will automatically open if the “Show Revision History When Saving as New Project” box is checked in 

the “i-CHoose - Preferences” → “Options” dialog box. 

 

Figure 3-90: Check the Revision History Checkbox in the Options 

3.4.2 Revision History Dialog Box 

The “Revision History” dialog box is there to provide a means to describe and document the various changes 

and evolutions made to the project. It contains the following: 

• Revision selection list: Will display all of the revisions that have been created and 

documented.  A user needs to select the revision to see its description and comments. This field 

begins at 0 (no revision) and is automatically incremented by 1 each time there is a new revision. 

• Revision comment field: Open field that allows the user to input the information for a specific 

revision. 

• Revised by field (Mandatory): Open field that allows the user to input the information for a 

specific revision. 

• Date field: This field is automatically filled with the current date when the reviser writes or 

modifies his name.  

• Verified by field: Open field that allows the user to input the information for a specific 

revision. 
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• Date field: This field is automatically filled with the current date when the user writes or 

modifies his name. 

• Approved by field: Open field that allows the user to input the information for a specific 

revision. 

• Date field: This field is automatically filled with the current date when the approver writes or 

modifies his name. 

• Create new revision button: Allows the user to create a new revision. This button increments 

the revision number by one. It can only be used when someone puts their name in the “Revised 

by” field.  

 

Figure 3-91: Revision History Dialog Box 

3.4.3 Revision History Interface – Creating Revisions 

3.4.3.1 Revision History Interface – Creating a Revision 

At the beginning, no revision is created. All the fields are grayed out. 

To create a new revision, the user must click on the “New Revision” button.  A new revision number appears 

in the revision list. 

This will be considered the identifier of the new revision. Then, all of the information needed for the revision 

must be entered in the corresponding fields of the new revision. 

The “Revised by” field must be filled (Mandatory) to be able to validate the revision (OK) or to create a new 

revision (New Revision). 

When a new revision is created, the older revisions can no longer be modified. 

The CANCEL button cancels all the modifications 
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Figure 3-92: Creation of a New Revision 

3.4.3.2 Locking some fields for a revision 

The user can “lock” some fields using a button to the right of the field. Once a field is locked, it can no longer 

be modified (After hitting OK). 

 

Figure 3-93: Creation of a New Revision 

3.4.3.3 Revision History Interface – Viewing a Revision 

To view a revision and its description: 

1. Select the correct revision number from the “Revision” drop-down list. 

3.4.3.4 Revision History Interface – Modifying a Revision 

Only the last active revision is available for modification. The previous revisions are locked and can only be 

viewed. 

By default, the Revision History dialog shows the last revision. The user can modify the fields as desired and 

confirm with the OK button.  
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3.4.3.5 Revision History Interface – Clearing the revision history 

When saving a project with a different name (File/Save As…), and if the project already has a revision, the 

user is prompted with a message asking whether or not to modify the revision history (If the “Check the 

Revision History” is checked in the “options” dialog in the Preferences/Options menu.)  

 

Figure 3-94: Revision History Confirmation 

Yes → the revision dialog opens and a “Clear” button is visible on the bottom-left. 

The user can modify or clear all the existing revisions. The project is then saved. 

No → the project is saved without displaying the revision dialog. 

 

Figure 3-95: Clear Revision History
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3.5 Price Parameters 
This dialog is used to specify and adjust various price parameters: 

▪ the price list selection 

▪ the discount schedule for the reports 

It is only available to certain users. 

 

Figure 3-96: Price Parameters Dialog 

3.5.1 Price List Selection 

This section allows the user to specify the price list that will be used to calculate the prices (if available). For 

more information, please contact Bosch Rexroth. 

3.5.2 Discount Schedule (CDV, CPM Only) 

The discount schedule section allows the user to specify up to five quantity breaks and their associated 

discount percentage.  

If a Quantity field is left empty, the discount for that line will not be used or displayed in the report. 

The discount field is used to calculate the unit price for the corresponding quantity break (see figure below). 

 

Figure 3-97: Discount Schedule Section in the Report
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3.6 Software Options 
Software options are used to customize some of the application’s global parameters.  

 

Figure 3-98: Software Options 

 

 The options include: 

1. User Profile: 

o User Code (provided by Bosch Rexroth - used to automatically generate the project 

number) 

o User’s company name 

o User’s address 

o User’s city 

o User’s country 

o User’s contact name 

o User’s phone 

o User’s e-mail 

o “Copy to Project Parameters” checkbox: Automatically copy a part of the user profile 

to the project parameters of a new project. 
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2. Miscellaneous: 

o Language. The change will take effect after restarting the application 

o Default unit system (Imperial or Metric). This option will specify the units that will 

be used in the next project that will be created. It will not be possible to change the 

unit system of a project after its creation 

o Library – The pressure/flow can be added near the component reference in the 

library. Indicate the format of the data to display. 

o Prompt for a Wizard Help when the application Starts-up 

o Show Revision History when saving as a new project 

o Prompt for confirmation of the “Fit to Block” function. If checked, a confirmation 

dialog will be displayed each time the user clicks the ‘Resize to Fit’ button in the 

Manifold Layout 

o CDV – Model Code Automatic Positioning – Automatically groups the model codes 

of connected CDV elements 

o Enable Unsaved Files Recovery – When i-CHoose closes unexpectedly, prompts the 

user to recover unsaved files. 

 

3. Connection Lines: 

o Default Pressure Line Configuration; 

o Default Drain Line Configuration 

o Default Pilot Line Configuration 

o Default Load Sense Line Configuration 

o Default Return Line Configuration 

 

4. Colors & Background options: 

o Unconfigured Component Color 

o Not Released Component Color 

o Diagram Background 

 

5. HydSel (Pro Version Only): 

o HydSel Database – Path to the HydSel Database. The buttons marked “…” are used 

to browse for the file. The checkbox enables/disables the HydSel file. If the path is 

incorrect or if it is impossible to read the HydSel database, the textbox background is 

red. 

o UDF Root Folder – Path to the UDF root folder. The buttons marked “…” are used to 

browse for the folder. The checkbox enables/disables the UDF folder. If the path is 

incorrect, the textbox background is red. 
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3.7 3D Options 
The i-CHoose application relies heavily on the graphics card in order to render the 3D views. Thus, for large 

blocks with a lot of components, the responsiveness in the 3D views can decrease considerably depending on 

the graphics card’s capabilities.    

This dialog is used to adjust the quality of the 3D views depending on the graphics card’s capabilities: 

 

 

Figure 3-99: 3D Options Dialog 

The 3D visual definition section is used to adjust the quality of the components and cavities in the 3D 

representation.  

The highest definition setting is recommended for computers with a good graphics card.  

The highest performance option is recommended for computers with an older graphics card. However, the 

visual representation of the components could be degraded. 
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3.8 Dimensioning Tool 
Dimensions can be added on the 3D Layout interface in all project types. Dimensions are created from 

predefined anchor points or user-defined anchor points. 

Dimensioning can be done in two different styles: linear or ordinate. Dimensioning styles can be selected from 

the “Design” tab → “Annotations” group → “Dimensions” → “Linear Dimension” or “Ordinate Dimension”. 

A third option (“Default Dimension Options”) is used to modify the default font of the dimensions. (See 

“Annotation Options” chapter) 

3.8.1 Linear Dimension 

Create a linear dimension by clicking on the “Linear Dimension” ribbon bar button. Once activated, anchor 

points (colored squares) appear on the views. The dimensioning process begins by clicking on the first desired 

anchor point and moving the mouse. A line attached to the mouse pointer is automatically drawn. Clicking on 

the destination anchor point creates the dimension. Move the mouse to position and orient the dimension text. 

Once the dimension text is positioned correctly and in the right orientation, the dimension is finalized by 

clicking one last time in order to fix the dimension layout and finish the dimensioning process. 

 

 

Figure 3-100: Linear Dimensions 

3.8.2 Ordinate Dimension 

Create an ordinate dimension by clicking on the “Ordinate Dimension” ribbon bar button. Once activated, 

anchor points (colored squares) appear on the views. The dimensioning process begins by clicking on the 

desired anchor point. This automatically creates the dimension from the origin, shown as the red dot on each 

view. Move the mouse to position and orient the dimension text. Once the dimension text is positioned 

correctly and in the right orientation, the dimension is finalized by clicking one last time in order to fix the 

dimension layout and finish the dimensioning process. Notice that the “0” dimension is created at the same 

time. 
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Figure 3-101: Ordinate Dimensions 

 

The dimensioning text can be placed in the middle, on one side or on the other side. 

 

To remove a dimension, click on the text or the arrows to select it, and then use the delete key or the ribbon 

bar button. 

See the “Dimensions (Annotations)” section for more details about dimension related features. 
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3.9 Title Block 
 

To select the default title block for the “Hydraulic Circuit” or “Technical Drawing” document of new projects, go to “i-

CHoose menu” → “Preferences” → “Default Hydraulic Circuit Options” or “Default Technical Drawing Options” → 

Default Page Setup”. 

 
Figure 3-102: Title Block (Example) 

To override the title block of the current “Hydraulic Circuit” or “Technical Drawing” document, click on the 

ribbon bar “Design” → “Current Circuit Setup” → “Current Page Setup” → “Title Block” section. 



 i-CHoose User's Guide 

  

 3-78 

 
Figure 3-103: Current Circuit Setup Dialog 

To override the title block of the current “Technical Drawing” document, click on the ribbon bar “Design” → 

“Current Drawing Setup” → “Current Page Setup” → “Title Block” section. 
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Figure 3-104: Current Drawing Setup Dialog 

To display or hide the title block on the current project, click on the ribbon bar “View” → “Show” → “Title 

Block” 

The title block’s dynamic content is extracted from the project itself or from within the program: 

▪ Project name: the « project » name in the Project Parameters interface 

▪ Project type: HIC, CDV or CPM (concatenated with the project name) 

▪ Project number: the « Project Number » in the Project Parameters interface 

▪ Revision Number: concatenated to the Project number if there is a revision 

▪ Application: the « Application » in the Project Parameters interface 

▪ Function: the « Function » in the Project Parameters interface 

▪ Customer Name: the « Customer Name » in the Project Parameters interface 

▪ Estimated Weight (in pounds or kilograms): calculated from the individual weights of the 

elements within the project 

▪ Designer Name: the « Designer Name » in the Project Parameters interface 

 

In PRO mode only (Engineers) - In order to fill the undefined parameter fields, the user double-clicks on the 

Title Block (A dialog opens and contains 3 columns). 

- Parameter: The name of the parameter  
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- Value: The value of the parameter which could be extracted from a property of the project. In this case, the 

field is gray and read only. Otherwise, it is blank and read/write. 

- Overridden: Checkbox available only for predefined values. If checked, the “Value” field becomes 

read/write and can be overwritten. 

 

Figure 3-105: Title Block Information – Editing Mode 

 

 



4 Documentation 

. 

4.1 Introduction 
The report is the main objective of the i-CHoose application. It summarizes all of the information 

required to build the hydraulic system. It includes: the project information, component list, 

placement, revisions, warnings, disclaimer, schematics and 3D layout. 
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Figure 4-1: Report (Partial) 

4.2 Part List (BOM) 
The Part List interface is a simple bill of material (BOM) of the current hydraulic system. 

Items that appear in the list are: 

▪ All components/elements found in the hydraulic circuit 

▪ Components/elements not present on the hydraulic circuit such as mounting holes, fittings, 

bolts, tie-rods, nuts, washers … 

Row height and column width can be adjusted using the separators in-between the rows or the separators 

between the column headers. 

Information in the table can be sorted alphabetically by column by double-clicking on the desired column 

header.   

Table content can be copied and pasted into a spreadsheet application (like MS Excel) 
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Figure 4-2: Part List Interface 
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4.3 Technical Drawing 
 

The Technical Drawing interface is used to create a specific layout with multiple views of the assembled 

project on a page with an optional title block and map locator. 

 

Figure 4-3: Technical Drawing 

Elements from different documents within the project are listed in the library: the hydraulic circuit schematic, 

the 3D view, the multiview projection (6 faces of the block), the part list, the technical data and the Ordering 

Code (CPM projects only). 

 

Elements can be manually dragged & dropped from the library onto the Technical Drawing page. While 

manipulating the views, guidance boxes are displayed in order to easily layout the desired view and avoid 

representation errors. 

 

The orthogonal views can be positioned automatically by clicking on the “Auto Create” button from the 

“Design”→ “Positioning” group. This will create all 6 projections and position them appropriately on the page 

according to the drawing setup options. 
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4.3.1 Positioning the Technical Drawing Elements 

The Technical Drawing interface requires specific design features which are available under the “Design” tab 

→“Page Layout” group.  

 
Figure 4-4: Technical Drawing Tools 

4.3.1.1 Automatic Positioning 

Using the “Auto-Create” command, a single click completes all the operations required to create a technical 

drawing. The user can simply click on the “Auto-Create” icon in the “Design” tab → “Positioning” group 

→  

This will automatically position the technical drawing elements, including the ballooning of the block 

components and a complete dimensioning of the block. The automatic view positioning and annotation 

commands (Dimensioning and Ballooning) can also be launched separately through the drop-down list 

beneath the “Auto-Create” command. The system will position all the elements on the page taking into 

account various parameters such as page margins, projection configuration, elements to insert, etc. 

The auto-positioning options for the current project can be configured by clicking on the “Current Drawing 

Setup” icon in the “Design” tab → “Settings” group → . 

Note: The layout of the views (6 or 3 views, L or ┌, etc.) depends on the 

manufacturing site. Once positioned, the current Projection Angle defines only the 

faces. 

4.3.1.2 Manual Positioning 

Individual drawing elements are displayed as images in the library. These vector graphics can be taken from 

the library and dropped onto the page. Each vector image can be resized by using the handles, except for the 

orthogonal views which are managed by the selected scale factor in the Design tab → Page Layout group → 

Scale drop-down list. 

The orthogonal views are positioned according to particular layout rules: first or third angle projection, scale, 

alignment, etc... 

4.3.1.2.1 Selecting the Projection Angle 

Existing drawing standards (ASME, BS, ISO…) suggest that the multiview drawings can be laid out following 

two different projection angles, First and Third. 

4.3.1.2.2 Default Projection vs Region 

Upon the project creation, the projection angle is set by default according to the selected region (Italy, USA, 

China…).  

 
Default Projection Angle vs Region: 
 

Australia Third Angle Projection (US) 

Brazil First Angle Projection (Euro) 
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Canada Third Angle Projection (US) 

China First Angle Projection (Euro) 

Germany First Angle Projection (Euro) 

India First Angle Projection (Euro) 

Italy First Angle Projection (Euro) 

Japan Third Angle Projection (US) 

Korea First Angle Projection (Euro) 

US Third Angle Projection (US) 
 

These are used as the reference for selecting the correct default template for the corresponding project type, as 

follows: 

Examples of the layout of views for the First Angle (Euro) Projection:  

Multiview – 6 Views (HIC) Multiview – 3 Views (CDV, CPM) 

 

 Bottom   

Right Front Left Back 

 Top   
 

 

Right Front 

 Top 
 

Examples of the layout of views for the Third Angle (US) Projection:  

Multiview – 6 Views (HIC) Multiview – 3 Views (CDV, CPM) 

 

 Top   

Left Front Right Back 

 Bottom   
 

 

Top  

Front Right 
 

4.3.1.2.3 Modifying Projection Angle 

The projection angle can be changed by clicking on the split button and selecting another type (First Angle 

Projection - Europe and the Third Angle Projection - US). The Projection Type button is located in the Design 

tab → Page Layout group. 

 

 
Figure 4-5: Design Tab → Projection Angle Selection 

4.3.1.2.4 Technical Drawing Library 

The library contains all the available elements for the Technical Drawing. 

▪ Hydraulic Circuit 

▪ 3D View 

▪ Multiview Projections 

▪ Part List 

▪ Technical Data 

▪ Ordering Code (CPM project only) 
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Figure 4-6: Library – Technical Drawing  

4.3.1.2.5 Scaling (Orthogonal Views) 

To modify the scale, select the desired ratio from the scale drop-down list located in Design tab → Page 

Layout group → Scale drop-down list. The size of the existing views already on the page are automatically 

adjusted to the selected scale. Newly inserted views will use the same scale ratio. 

 
Figure 4-7: View Scale Drop-Down List 
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As a reminder, the only way to modify the size of the orthogonal views is via this drop-down list. All of the 

other graphical elements can be resized using the resize handles. 

Note: A scale of 1:1 implies that the object has been drawn to true size. Therefore, a 

scale of 1:2 implies that the object has been reduced to half its size on the drawing. 

4.3.1.2.6 Orthogonal View Alignment 

Alignment lines are shown when a view is moved on the page in order to easily align it with the other views 

that are already on the technical drawing.   

 

 

Figure 4-8: Moving View Alignment Lines 

4.3.1.2.7 Moving Orthogonal Views 

The available destination positions appear when a view is moved in a direction other than the alignment axis. 

The view can only be moved (dropped) to the proposed areas. The same mechanism is used when the view is 

inserted from the Library. 

When the view is dropped on the destination location, it is automatically updated and is positioned in the 

correct orientation. 

 
Figure 4-9: Moving View – Available Areas 
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4.3.1.2.8 Using the Current 3D Layout Orientation 

Regarding the 3D view element, the “Update All Views” command in the contextual menu regenerates the 3D 

view while keeping the same orientation (Not the one on the 3D Layout). If the user wants to regenerate the 

view corresponding to the 3D layout, they must use the “Use the Current 3D Layout Orientation” command 

available in the contextual menu (See below).  

 

 

Figure 4-10: Current 3D Layout Orientation 

4.3.1.2.9 Changing a View (Multiview Projections) 

Each view can be switched with another one using the contextual menu of the Multiview projection. 

 

Figure 4-11: View Change 

Once the view is changed, all the adjacent views are recalculated consequently. 

4.3.1.2.10 Opening the Source Document 

The “Open Source Document” command in the contextual menu gives the focus to the source document of the 

element (Schematic, 3D Layout, Part List ...) 

 

 

Figure 4-12: Source Document Link 
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4.3.1.2.11 Managing Pages 

Other pages can be created in order to insert the orthogonal views, 3D view, schematic, technical data and the 

part list. 

 
Adding Page 

Multiple pages can be added by clicking on the “Add Page” button in the Design tab → Page Layout group. 

 
Figure 4-13: Add/Remove Page 

The new pages of the Technical Drawing are displayed one after another with an associated page number. 

 
Figure 4-14: Multi-page Number 

Each page is not considered to be stand-alone, which means that a view of the projection can only be 

displayed on one page. Duplications are not allowed. 

 
Select Page 

The page is automatically selected once a click has been done on a page (including the content). The page 

number located in the top/right corner of the active page is highlighted.  

 
Figure 4-15: Active Page Indicator 

Select a page by clicking anywhere on the page or on the page number. 

If there are several pages, the “Zoom Page” button and other similar commands in the ribbon bar will affect 

the selected page. 
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Note: At least one page remains selected at all times. In other words, it is not 

possible to have no page selected. 

 
Delete Page(s) 

Selected pages can be removed by clicking on the “Remove Page” button in the Design tab → Page Layout 

group. 

Similarly, using the right-click on a page opens the contextual menu which contains a command to remove the 

page. 
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4.3.2 Updating Views 

4.3.2.1 Schematic or Layout Changes 

If modifications are made in the project (new component, new option, schematic, 3D layout, BOM, etc…) the 

multiview elements are not automatically updated in order to prevent the application from slowing down. 

If some components have been modified, then a warning icon is overlaid on the elements to indicate that they 

need to be updated.  

(*) Some visual modifications, such as diagram grid, 3D rotation, component spacing, panning the 

diagram/image, are not taken into consideration. In these cases, no warning is triggered. 

An icon in the top right corner of a view indicates that the view is not up-to-date. 

Outdated views can be updated by clicking on the “Update Draft Views” button in the Design tab → Page 

Layout group or using the contextual menu → “Update All Views (Draft)” 

 

 

Figure 4-16: Update (Draft) Ribbon and Contextual Menu 

 
Figure 4-17: Outdated View Needing an Update 

4.3.2.2 Technical Drawing Quality 

In order to optimize the process of positioning the graphical elements and reduce lag, a draft quality is used 

for manual or automatic placement of the orthogonal or isometric views. Draft views are not finalized and 

some elements may have missing edge or internal lines. 

To refine the graphical aspect and finalize the technical drawing, an extra step is required to generate the 

“Final” version with all lines, shapes and outlines. 

 

All draft views can be updated to final views by clicking on the “Update Final Views” button in the Design 

tab → Page Layout group or using the contextual menu → “Update All Views (Final)”. 

Note: The “Update Final Views” icon is available only if all “Draft” views are updated. Additionally, once 

the views are updated to “Final”, the “Update Final Views” icon is grayed-out. 

 A message appears after clicking on “Update Final Views” button: 
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Figure 4-18: Update (Final) Ribbon and Contextual Menu 

4.3.3 Adding Information 

Dimensions, balloons, supplemental texts, notes or CAD objects (line, rectangle, circle …) can be added to the 

page. For more information related to adding text, notes or CAD objects, please refer to the “Working with 

Graphical Elements” chapter under “Hydraulic Circuit” Interface section. 

4.3.3.1 Dimensions (Annotations) 

Dimensions can be added to the technical drawing (multiview). Dimensions are created from predefined 

anchor points or user-defined anchor points. 

4.3.3.1.1 Dimension and Label Visibility 

Dimensions and labels can be shown or hidden from the “View” tab → “Show” group. 

 
Figure 4-19: Show or Hide Commands 

Note: The Dimensions button is also used by the 3D Layout but is independent, i.e. 

the dimensions can be displayed on the Technical Drawing or/and the 3D Layout 

independently. 

4.3.3.1.2 Creating Dimensions 

Automatic dimensioning can be done by clicking on the “Dimensions” command  located in the drop-

down list under the “Auto-Create” command. 

Manual dimensioning can be done following two different styles: linear or ordinate. Dimensioning styles can 

be selected from the “Design” tab → “Annotations” → “Linear Dimensions” or “Ordinate Dimensions”. 
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Figure 4-20: Dimension Style and Options Menu 

Linear Dimension 

Create a linear dimension by clicking on the “Linear Dimension” ribbon bar button. Once activated, anchor 

points (colored squares) appear on the views. The dimensioning process is started by clicking on the first 

desired anchor point and moving the mouse. A line will be drawn between the mouse pointer and the first 

anchor point. Clicking on a second anchor point will then create the dimension. Move the mouse to position 

and orient the dimension text. Once the dimension text is positioned correctly and in the right orientation, 

click once more to fix the dimension layout and finish the dimensioning process.  

 

Figure 4-21: Linear Dimensions 

Ordinate Dimension 

Create an ordinate dimension by clicking on the “Ordinate Dimension” ribbon bar button. Once activated, 

anchor points (colored squares) appear on the views. The dimensioning process is started by clicking on the 

desired anchor point. This automatically creates the dimension from the origin, displayed as a red dot on each 

view. Move the mouse to position and orient the dimension text. Once the dimension text is positioned 

correctly and in the right orientation, click once more to fix the dimension layout and finish the dimensioning 

process. Notice that the “0” dimension is created at the same time. 
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Figure 4-22: Ordinate Dimensions 

4.3.3.1.3 Modifying Dimensions 

Modify the dimension text position by clicking on the text and moving the text to a new location. The text can 

be placed in the middle, or on either side of the dimension lines. 

 

Figure 4-23: Modified Dimensions 

Modify the leader lengths or the dimension’s distance from the object by clicking on the handle grip shown on 

the dimension arrow(s) and then drag the dimension to a new location. 

Delete a dimension by clicking on the dimension text or the arrows. Once selected, press the DELETE key or 

use the ribbon bar button located in the “Design” tab → “Clipboard” group. 

4.3.3.1.4 Creating Anchor Points 

Additional anchor points can be created to define specific dimensions. 
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Figure 4-24: Add/Remove Anchor Points Menu 

Create an anchor point by clicking on the “Add/Remove Anchor Points” ribbon bar button. Once activated, 

predefined anchor points appear in gray on the views. Add an anchor point by clicking on an existing line at 

the desired location. The new user-defined anchor point appears in bright green. 

 
Figure 4-25: Creating User-defined Anchor Points 

Delete a user-defined anchor point by clicking on an existing user-defined anchor point. 

Note: Predefined anchor points cannot be deleted. The esc key exits this mode. Once 

deactivated, all the anchor points return to the same color (blue). 

4.3.3.2 Balloons (Item Position - Annotations) 

A technical drawing contains the list of all the components (part list). Each component has a unique index 

(Item Position).  These indexes are displayed in the technical drawing layout as a reference in the bill of 

materials (BOM) for each part in the project. 
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Figure 4-26: Reference Balloons 

4.3.3.2.1 Visibility 

Balloons can be shown or hidden from the “View” tab → “Show” group → “Item Pos.”. 

 
Figure 4-27: Show or Hide Balloons 

By default, the balloons are visible on the Technical Drawing. 

Note: The “Component Position” of each component is displayed in a circle. A 

leader line is attached to the surface of the component. The size of the circle (or 

shape) is adapted to the paper size. 

4.3.3.2.2 Creating Balloons 

Balloons are automatically created for each component. Additionally, they are all automatically positioned. 

For HIC projects, balloons are positioned on the different multiview projections. 

The automatic balloon positioning can be relaunched through the “Dimensions” command  located in 

the drop-down list under the “Auto-Create” command. 
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Figure 4-28: Reference Balloons on Multiple Views 

Balloons are only positioned around views containing visible components. 

For CDV and CPM projects, balloons are positioned in the 3D view. 

  
Figure 4-29: Reference Balloons on 3D View (CPM) 

4.3.3.2.3 Modifying Balloons 

Modify the balloon position by clicking on the balloon and moving it to a new location.  
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. 

Figure 4-30: Moving a Balloon 

Modify the balloon leader, pointing arrow position, by clicking on the arrow tip and dragging it on the same 

object, from the same or another view. Note that it cannot be located outside the object. 

 
Figure 4-31: Moving a Balloon to another View 

Balloon font size can be modified by double-clicking on it or using the contextual menu. The “Font” dialog 

opens. 

 
Figure 4-32: Changing Balloon Font Size 

Show or hide a balloon using the contextual menu available from the component or from the balloon circle: 

1. If the balloon is shown: it can be hidden from its contextual menu → “Hide Item (Pos.) Balloon” 
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Figure 4-33: Hiding a Balloon 

2. If the balloon is hidden: it can be shown from its contextual menu → 

“Show Part List Item (Pos.) for xyz” 

 
Figure 4-34: Showing a Balloon 

 

 

3. Balloons can be moved to another view by right-clicking on the component in another view and 

selecting “Show Item Pos. Balloon...” The balloon corresponding to the clicked component appears 

linked to the object, and is removed from the previous location. 

Note: Only one balloon can be displayed for each object (component block, valve, 

coil, connector etc.). A balloon can be shown on one view at a time - if a balloon is 

shown on a view, it will be removed from the other views. 

Some components have sub-components. In this case, the contextual menu gives the information on all the 

sub-components. 

 
Figure 4-35: Showing a Sub-component Balloon 
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4.3.3.2.4 Balloon Check 

Open the contextual menu from a blank space on the page in order to check if all the balloons have been 

placed on the page(s).  

 
Figure 4-36: Checking Balloons Status 

Green icon: the balloon is already on the page. 

Orange icon: the balloon is not on the page but a compatible view is available on a page. 

Grey icon: the balloon is not on the page and no compatible view is available on the page. The name of the 

missing view is displayed. 

Clicking on an orange balloon will position it somewhere else on a view. 

Clicking on a green balloon will hide it. 

4.3.3.3 Dimensions and Balloons Options 

A contextual menu is available from an empty surface of the page and can be used to change the Font of the 

Dimensions, the Item (Pos.) balloons and the Callouts. 

 
Figure 4-37: Changing Dimension, Callout or Balloon Font 
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4.4 Production Drawing 
 

The Production Drawing interface is used to create a 2D layout with the production views of the assembled 

project on a page with an optional title block and map locator. This document is only available in the PRO 

Version of i-CHoose. 

 

Figure 4-38: Production Drawing 

The “Multiview” production views from the 3D Layout are available in the library. 

The “Multiview” views can be manually dragged & dropped from the library to the Production Drawing page. 

The inserted view depends on where it is dropped on the production drawing. 

The orthogonal views can be positioned automatically by clicking on the “Auto-Create” button from the 

“Design”→ “Positioning” group.  This will create all 6 projections and position them appropriately on the 

page. 

 

4.4.1 Positioning the Production Drawing Elements 

The Production Drawing interface requires specific design features which are available under “Design” tab 

→“Page Layout” group. 
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Figure 4-39: Production Drawing Tools 

4.4.1.1 Automatic Positioning 

Using the “Auto-Create” command, a single click completes all the operations required to create a production 

drawing. The user can simply click on the “Auto-Create” icon in the “Design” tab → “Positioning” group 

→  

This will automatically position the production drawing elements, including the drilling identifiers and 

locations and the drill lists for each face of the block. The automatic positioning commands for views, 

dimensions and drilling identifiers can also be launched separately through the drop-down list beneath the 

“Auto-Create” command. The system will position all the elements on the page taking into account various 

parameters such as page margins, projection configuration, elements to insert, etc. 

The auto-positioning options for the current project can be configured by clicking on the “Current Drawing 

Setup” icon in the “Design” tab → “Settings” group → . 

4.4.1.2 Manual Positioning 

Individual drawing elements are displayed as images in the library. These vector graphics can be taken from 

the library and dropped onto the page. Each vector image can be resized by using the handles, except for the 

orthogonal views which are managed by the selected scale factor in the Design tab → Page Layout group → 

Scale drop-down list. 

The orthogonal views are positioned according to particular layout rules: first or third angle projection, scale, 

alignment, etc... 

4.4.1.2.1 Selecting the Projection Angle 

According to various drawing standards (ASME, BS, ISO, …), multi-view drawings can be laid out following 

one of two different projection angles, First and Third. 

The projection angle can be changed by clicking on the split button and selecting the other type (First Angle 

Projection - Europe and Third Angle Projection - US). The Projection Type button is located in the Design tab 

→ Page Layout group. 

 

 
Figure 4-40: Design Tab → Projection Angle Selection 

4.4.1.2.2 Production Drawing Library 

The library contains the multiview projection and the drill list tables for each face of the manifold: 
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Figure 4-41: Library – Production Drawing  

4.4.1.2.3 Scaling (Orthogonal Views) 

To change the scale, select desired ratio from the scale list box located in Design tab → Page Layout group → 

Scale drop-down list. The size of existing views already on the page automatically changes to adjust to the 

selected scale. Newly inserted views will use the same scale ratio. 

 
Figure 4-42: View Scale Drop-Down List 



 i-CHoose User's Guide 

  

 4-25 

The only way to change the size of the orthogonal views is via the scale setting in this list box. All the other 

graphical elements can be resized by using the handle selection. 

Note: A scale of 1:1 implies that the object has been drawn to true size. Therefore, a 

scale of 1:2 implies that the object has been reduced to half its size on the drawing. 

4.4.1.2.4 Orthogonal View Alignment 

Alignment lines are shown when a view is moved on the page in order to easily align it with the other views 

that are already on the production drawing. 

  

Figure 4-43: Moving View Alignment Lines 

4.4.1.2.5 Moving Orthogonal Views 

When a view is moved in a direction other than the alignment axis, the available destination positions appear. 

The view can only be moved (dropped) in the proposed areas. These destinations are also displayed. 

When the view is dropped in the destination location, it is automatically updated and is positioned in the 

correct orientation. 
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Figure 4-44: Moving View – Available Areas 

4.4.1.2.6 Changing a View (Multiview Projections) 

Each view can be switched with another one using the contextual menu of the Multiview projection. 

 

Figure 4-45: View Change 

Once the view is changed, all the adjacent projections are updated according to their positions relative to the 

new view. 

4.4.1.2.7 Opening the Source Document 

The “Open Source Document” command in the contextual menu will open the project on the source of the 

element (Views, Drill list…) 
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Figure 4-46: Source Document Link 

4.4.2 Updating Views 

4.4.2.1 Schematic or Layout Changes 

If modifications are made in the project (new component, new option, schematic, 3D layout, BOM, etc…) the 

multiview elements are not automatically updated in order to prevent the application from slowing down. 

If some components have been modified, then a warning icon is overlaid on the elements to indicate that they 

need to be updated.  

(*) Some visual modifications, such as diagram grid, 3D rotation, component spacing, panning the 

diagram/image, are not taken into consideration. In these cases, no warning is triggered. 

An icon in the top right corner of a view indicates that the view is not up-to-date. 

Outdated views can be updated by clicking on the “Update Draft Views” button in the Design tab → Page 

Layout group or using the contextual menu → “Update All Views (Draft)” 

 

 

Figure 4-47: Update (Draft) Ribbon and Contextual Menu 

 
Figure 4-48: Outdated View Needing an Update 

4.4.2.2 Production Drawing Quality 

In order to optimize the process of positioning the graphical elements and reduce lag, a draft quality is used 

for manual or automatic placement of the orthogonal or isometric views. Draft views are not finalized and 

some elements may have missing edges or internal lines. 

To refine the graphical aspect and finalize the technical drawing, an extra step is required to generate the 

“Final” version with all lines, shapes and outlines. 
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All draft views can be updated to final views by clicking on the “Update Final Views” button from the Design 

tab → Page Layout group or using the contextual menu → “Update All Views (Final)”. 

Note: The “Update Final Views” icon is available only if all “Draft” views are updated. Additionally, once 

the views are updated to “Final”, the icon “Update Final Views” is grayed-out. 

 A message appears after clicking on “Update Final Views” button: 

  

Figure 4-49: Update (Final) Ribbon and Contextual Menu 

4.4.3 Adding Information 

Dimensions, balloons, supplemental texts, notes or CAD objects (line, rectangle, circle …) can be added to the 

page. For more information related to adding text, notes or CAD objects, please refer to the “Working with 

Graphical Elements” chapter under “Hydraulic Circuit” Interface section. 

4.4.3.1 Dimensions (Annotations) 

Dimensions can be added to the production drawing. Dimensions are created from predefined anchor points or 

user-defined anchor points. 

4.4.3.1.1 Dimension Visibility 

Dimensions can be shown or hidden from the “View” tab → “Show” group → “Dimensions”. 

 
Figure 4-50: Show or Hide Dimensions 

Note: The button is also used by the 3D Layout but is independent, i.e. the 

dimensions can be displayed on the Production Drawing or/and the 3D Layout 

independently. 

4.4.3.1.2 Creating Dimensions 

Automatic dimensioning can be done by clicking on the “Dimensions” command  located in the drop-

down list under the “Auto-Create” command. 
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Manual dimensioning can be done following two different styles: linear or ordinate. Dimensioning styles can 

be selected from the “Design” tab → “Annotations” → “Linear Dimensions” or “Ordinate Dimensions”. 

 
Figure 4-51: Dimension Style and Options Menu 

Linear Dimension 

Create a linear dimension by clicking on the “Linear Dimension” ribbon bar button. Once activated, anchor 

points (colored squares) appear on the views. The dimensioning process is started by clicking on the first 

desired anchor point and moving the mouse. A line will be drawn between the mouse pointer and the first 

anchor point. Clicking on a second anchor point will then create the dimension. Move the mouse to position 

and orient the dimension text. Once the dimension text is positioned correctly and in the right orientation, 

click once more to fix the dimension layout and finish the dimensioning process.  

 

Figure 4-52: Linear Dimensions 

Ordinate Dimension 

Create an ordinate dimension by clicking on the “Ordinate Dimension” ribbon bar button. Once activated, 

anchor points (colored squares) appear on the views. The dimensioning process is started by clicking on the 

desired anchor point. This automatically creates the dimension from the origin, displayed as a red dot on each 
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view. Move the mouse to position and orient the dimension text. Once the dimension text is positioned 

correctly and in the right orientation, click once more to fix the dimension layout and finish the dimensioning 

process. Notice that the “0” dimension is created at the same time. 

 

Figure 4-53: Ordinate Dimensions 

4.4.3.1.3 Modifying Dimensions 

Modify the dimension text position by clicking on the text and moving the text to a new location. The text can 

be placed in the middle, or on either side of the dimension lines. 

 

Figure 4-54: Modified Dimensions 

Modify the leader lengths or the dimension’s distance from the object by clicking on the handle grip shown on 

the dimension arrow(s) and then drag the dimension to a new location. 

Delete a dimension by clicking on the dimension text or the arrows. Once selected, press the DELETE key or 

use the ribbon bar button located in the “Design” tab → “Clipboard” group. 

4.4.3.1.4 Creating Anchor Points 

Additional anchor points can be created to define specific dimensions. 
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Figure 4-55: Add/Remove Anchor Points Menu 

Create an anchor point by clicking on “Add/Remove Anchor Points” the ribbon bar button. Once activated, 

the predefined anchor points appear in gray on the views. Add an anchor point by clicking on an existing line 

at the desired location. The newly created user-defined anchor point appears in purple as it is still selected. 

Previously created anchor points appear in bright green. 

 
Figure 4-56: Creating User-defined Anchor Points 

Delete a user-defined anchor point by clicking on an existing user-defined anchor point. 

Note: Predefined anchor points cannot be deleted. The esc key exits this mode. Once 

deactivated, all the anchor points return to the same color (blue). 

4.5 Generating the report 
To generate the report:  
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1. Click on the “Generate Default Report”  tool in the “Finalize” toolbar or  

2. Select one of the options in the drop-down list (available depending on the key configuration). 

 

Figure 4-57: File Menu (Generate Report) 

The report is created in PDF format on the local computer and can be saved under a different name/location. 

4.5.1 Options and Warnings before generating a report 

Before the report can be generated, a dialog opens and allows the user to: 

• Select the output language. The recommended value is indicated 

• Select a specific output directory or the default one 

• Select a specific company logo or the default one 

• Include the catalogue files (pdf) in the report directory 

• Read the warnings regarding the project 
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Figure 4-58: Report Error/Warning Dialog 

 

The report output language list contains all the languages available in i-CHoose. The user can choose among 

all the available languages. 

When the “Specific Output Directory” is selected, all the report files are saved in a unique directory. The 

name of the directory is: Project Name + date + _integer (if needed) 

4.5.2 Saving the report 

When the report is generated, click on the PDF viewer “File” menu and use the “Save As…” command. This 

is a standard Windows function. 

4.5.3 Printing 

When the report is generated and opened in a PDF viewer application, click on the “File” menu and use the 

“Print” command. This is a standard Windows function. 

4.5.4 Report Contents 

The report contents will vary depending on the design.  For a standard report, the following information is 

included: 

• Company Logo, project status and revision 
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• Project information sheet (Project, customer, commercial, technical information) 

• Bill of Materials (BOM)  

• Project Summary 

• Price range and discount information (CDV and CPM only) 

• Warnings and Errors 

• Revision history 

• Placement constraints 

• Hydraulic Circuit (Diagram) 

• 3D Layout 

• Technical Drawing 

• Terms and Conditions of sales 


